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Overview

The purpose of this Guidebook is to reduce the consulting time needed to adapt layout sets. Because more
than 80 percent of external communication output can be created with eight layout sets, this book will be
useful. As an application consultant, although you may know your applications well, one tough job you
may face is adapting a layout set to customers’ needs.

About This Guide

SAPscript offers more functionality than is necessary for creating layout sets and is more useful for word
processing than layout sets. This Guidebook explains which SAPscript parts are necessary for layout sets
and which are not. The book is divided into the following sections:
1. An overview of output creation with R/3.
2. A guide for bringing layout sets, which are a better fit with U.S. and Canadian markets, into the

system. For users focusing on the Australian market, there is a section on copying layout sets between
clients.

3. A brief description of the SAPscript needed to understand layout set parts.
This description is necessary to understand the “How-To” section in chapter 5.

4. A “How-To” section that describes the possible changes in existing layout sets and using SAPscript to
implement these changes.

5. An overview of existing third-party solutions available for output creation.
6. A question-and-answer section on customizing output.
7. Theoretical information on SAPscript control commands.

Please look at the commands to understand the available formatting options and the options you may
want to use.

8. A glossary.
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9. An Appendix that includes the sample output we created with the layout sets from the Pre-Configured
Client (PCC) and the diskette inside the back cover of this Guide.

10. This diskette has the eight layout sets ready to upload into a customer’s system.
If you are using the PCC, you do not have to upload these sets.

For Who is This Guide Written?

This Guidebook is for Applications Consultants and Implementation project team members who do not
know SAPscript. (The Project team members are experienced in the applications’ customizing.)

Assumptions

 For this Guidebook to be useful, the following assumptions are made:

• This book is for the U.S., Canadian, and Australian markets.

• A Company normally uses only a few layout sets to create most of the printed output for the external
communication. The following adapted layout sets for output produce more than 80 percent of the
typical output:

- Sales Order Confirmation

- Packing List, Picking List

- Invoice

- Purchase Order

- Check (Pre-numbered for the U.S. and Australia)

In addition, this guide covers the production layout sets although they are not externally used.

• A consultant and the implementation project team members know the application sufficiently enough
to view every document screen.

• Except for producing checks in the U.S. and Australia, a company will not use preprinted forms; the
only preprinted item on an output page may be the company logo.

• If your R/3 System uses the Correction and Transport System (CTS), then you know how to handle
CTS screens. Since this is a Basis issue, it will not covered in this Guidebook.

Please consult your system administrator for this issue.

• You must know how to use the OSS to get an access key to modify R/3 objects.

Please consult your system administrator for this issue.
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The Most Important Layout Sets

The following table shows the names of the most frequently required layout sets on the diskette, in the
PCC, and in the SAP standard system.

Output name Diskette/Preconfigured Client Name SAP Standard Name

SD Sales Order Confirmation J_9H_RVORDER01 RVORDER01

SD Packing List J_9H_RVDELNOTE RVDELNOTE

SD Picking List J_9H_RVPICKSIN RVPICKSIN

SD Invoice J_9H_RVINVOICE01 RVINVOICE01

MM Purchase Order J_9H_MEDRUCK MEDRUCK

FI Prenumbered Check (US) J_9H_PRENUM_CHCK F110_PRENUM_CHCK

FI Check (CDN) J_9H_PRE_CHCK_CN F110_PRENUM_CHCK

PP Goods Issue Slip J_9H_PSFC_LAYOUT PSFC_STD_LAYOUT

PP Pick List J_9H_PSFC_LAYOUT PSFC_STD_LAYOUT

PP Confirmation Slip J_9H_PSFC_LAYOUT PSFC_STD_LAYOUT

PP Time Ticket J_9H_PSFC_LAYOUT PSFC_STD_LAYOUT

PP Goods Receipt List J_9H_PSFC_LAYOUT PSFC_STD_LAYOUT

PP Operation Control Ticket J_9H_PSFC_LAYOUT PSFC_STD_LAYOUT

PP Object List J_9H_PSFC_LAYOUT PSFC_STD_LAYOUT

PP Kanban Card J_9H_PSFC_KANBAN PSFC_KANBAN

Except for checks, the corresponding layout sets on the diskette and in the SAP standard vary only slightly
from each other. The main difference is that the layout sets on the diskette fit better on the U.S.-Canadian
page format (8 1/2” × 11”) , also known as “Letter” size, than the layout sets in the standard system.

Although R/3 provides a program to convert the page size of standard SAP layout sets from
the German “DIN A4” to the U.S. and Canadian “Letter,” please use the layout sets on the
diskette or in the PCC as a starting point for customizing because these layout sets are already
further customized for the target market. The program to convert the page format of layout sets
is called RSTXFCON.
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For checks, the difference between the diskette and the PCC and the SAP standard version is
significant. The SAP standard contains a pre-numbered check in the “DIN A4” format, and the
U.S. and Canadian format is 8 ½” x 7.”

How is The Guide Organized?

Chapter Title Contents

Introduction Describes the book’s audience, how the book is organized, and how to use
the book.

SAPscript, the Big Picture
in Small Words

Provides the “big picture” about how to print from the R/3 System.

Getting Started with
Copied Layout Sets

Describes what you need to do to transfer the provided layout sets from
the diskette or between clients.

A bit of Theory about
Layout Set Elements

Describes what you need to know about layout sets and SAPscript.

An easy Guide to Otherwise
Complicated Modifications

Describes how to make common changes to layout sets.

We will provide you with information on the changes and also include a
step-by-step example for each change.

Third-Party Solutions Provides a brief overview about existing third-party solutions for output
generation.

Printout-related
Customizing of the
Applications

Includes the customization of printing-related application areas.

SAPscript Control
Commands

Provides an overview on SAPscript control commands and formatting
options to help you create the desired layout.

The book also contains a Glossary, an Appendix, and an Index. The Appendix contains sample document
printouts and layout sets used in this Guide.
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How to Use this Guide

Depending on your level of knowledge about SAP and SAPscript, we recommend the following:

• If you have little, or no, knowledge about SAPscript, begin with Chapter 2.

• Everyone should read Chapters 3 and 4 to upload the provided layout sets. These chapters are an ideal
starting point and will help you understand the SAPscript you need.

• Depending on the desired changes and the details you need, Chapters 5, 6, 7, and 8 help you select the
applicable sections.

Certain terms, user information, and special icons are used in this Guidebook. The following sections
explain how to identify and understand these helpful features.

Terminology
The following are explanations of the terms used throughout this guide.

Click
When you see the word “Click”, use the mouse to point and perform the action.  For example:

1. Click Startup…

Use your left mouse button to click
the on-screen button labeled
“Startup…"

Menu Path

To follow the menu path, choose the first menu item and each sub-menu item until the path is complete.
Please see the example on the following page.

1
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1. Choose File → Save.

User Steps and Typeface Styles
The steps that require action and/or text to be entered into a field or at a command prompt are numbered.

Object style is italicized text, which indicates that the word is an on-screen button or field, or a noun such
as a book, an operating system, or an application.

User input is text, numbers, or symbols that the user enters and is represented by bold courier font.

For example:

1. Enter SAP* in User.

2. Click Parameters.
This step allows you to enter
search parameters.

The first step is numbered, so an action is required. User is italicized because it refers to an on-screen object
(a field in this case). SAP* is in the User Input style to indicate information that must be entered in a field.

The second step is numbered, so an action is required. Parameters is italicized because it refers to an on-
screen button.

1

2

1
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Special Icons
Throughout this guide you will see special icons indicating the presence of important messages. Here is a
brief explanation of each icon:

This textbox is a warning message. Please read this information carefully to avoid problems!

This textbox provides the nerdy details. Although life is possible without this information,
these are the details if you want to understand the topic in depth.

This textbox provides helpful hints or shortcuts to make your work faster or easier.
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Chapter 2:   SAPscript, the Big Picture in Small Words

Document Layout Set FormSupplies data
Gets

printed

SAPscript

Defines

If a user wants to print invoices or checks stored in the System, SAP allows the user to define these forms
by using layout sets. The tool that SAP provides for creating layout sets is called SAPscript. Once the
layout set is created, you can specify which layout set you want the System to use for a specific document.

To print a document, the SAP system runs a program that collects the document data and feeds this data
into the layout set the user has specified for that document.

SAP provides a standard layout set for every printable document, so that users do not need to re-create
layout sets.

If you do not want to use existing layout sets, copy and modify the layout set that closely matches
your needs. After you have modified this layout set, instruct the system to use your version
instead of the original.
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Chapter 3:   Getting Started with Copied Layout Sets
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Overview

This chapter helps you customize layout sets. When modifying these sets, ensure that you only change the
copies! If you need layout sets for the U.S. or Canada, begin with the sets in the disk from inside the back
cover of this guide or in the Pre-Configured Client (PCC). Upload the layout sets from the disk to your SAP
client or copy the layout sets from the PCC into your client. If you need layout sets for Australia, begin
with the standard layout sets from client 000 and copy the layout sets from client 000 into your client.

These two procedures are described in the following sections.

Uploading the Layout Sets

The disk contains the following nine files for the layout sets:

Output name File name

Sales Order Confirmation sorder.scr

Packing List delnote.scr

Picking List picklist.scr

Invoice invoice.scr

Purchase Order porder.scr

Prenumbered Check (US) pcheckus.scr

Check (CDN) pcheckcd.scr

PP Output pp_output.scr

PP Kanban Card pp_kanban.scr

The easiest way to import the layout sets into your R/3 system is to make the files available on the
presentation server, i.e. this is the computer where SAPGUI is running. Since this machine is usually a PC
with a disk drive, insert the disk into the correct drive. You may also place the files on the application
server. This process is complicated, especially if R/3 is running on a UNIX machine.
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1. Make the files available on the presentation
server, i.e. the front-end PC on which you are
logged. If this server is a PC that runs Windows
and has a disk drive, insert the disk and have
the files available on drive A.

In UNIX, if you copy the files with ftp, ensure that you use ASCII, not the binary mode.

2. Choose Tools → ABAP/4 Workbench
from the client that you want to
upload the layout sets.

Layout sets are client-dependent.
Therefore, the upload program only
creates the sets in the client where the
program is running.

3. Click ABAP/4 Editor.

2

3
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4. Enter RSTXSCRP in Program.

5. Click Execute.

6. Enter information in Object name
and Dataset name.

Refer to the table on the next page
for information about this step.

7. Enter IMPORT in Mode.
8. If you use the disk drive of the

presentation server, select File
system: GUI, otherwise select File
system: Server.

9. Click Execute.

4

5

6
7

8

9

6
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If you use a front-end PC and the disk drive is “A,” enter the following information in Object name and
Dataset name:

Output name Object name Dataset name

Sales Order Confirmation Z_9H_RVORDER01 a:\sorder.scr

Packing List Z_9H_RVDELNOTE a:\delnote.scr

Picking List Z_9H_RVPICKSIN a:\picklist.scr

Invoice Z_9H_RVINVOICE01 a:\invoice.scr

Purchase Order Z_9H_MEDRUCK a:\porder.scr

Prenumbered Check (USA) Z_9H_PRENUM_CHCK a:\pcheckus.scr

Check (CDN) Z_9H_PRE_CHCK_CN a:\pcheckcd.scr

PP Output Z_9H_PSCF_LAYOUT a:\pp_output.scr

PP Kanban Card Z_9H_PSCF_KANBAN a:\pp_kanban.scr

10. Enter the name of the dataset again.

11. Click OK.

The result is a protocol. A sales order confirmation
should look like the screen on the right.

10

11
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Copying Layout Sets Between Clients

If you are using the PCC, you may have to copy the provided layout sets from the PCC to another client.
Copying the layout sets is similar to copying layout sets from client 000, because you have to replace the
client number 000 with the PCC’s number. The PCC layout set’s names are the same names as on the disk
except the first letter is a J not a Z.

The following table contains the standard layout sets names delivered by SAP in client 000:

Output name Layout set name

Sales Order Confirmation RVORDER01

Packing List RVDELNOTE

Picking List RVPICKSIN

Invoice RVINVOICE01

Purchase Order MEDRUCK

Prenumbered Check F110_PRENUM_CHCK

PP Output PSCF_STD_LAYOUT

PP Kanban Card PSCF_KANBAN

If you do not want to use these layout sets, copy them into your client and change them. The following
procedure describes how to copy the layout set RVORDER01 for sales order confirmation. Using the data
established for the PCC, the name of the layout set should be J_9H_RVORDER01.

The new name of the copied layout set must begin with Y or Z, because the layout set name
must be in the customer name range to be modified later.

1. Choose Tools → Word processing →
Layout set.

1
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2. Choose Utilities → Copy from client.

3. Enter the layout set name in Layout
set name.

4. Enter Target layout set name,
replacing the first letter of the
layout set name with Z.

If you are copying data from the PCC,
the layout set name will be
J_9H_RVORDER01, the target name
must start with Y or Z, (e.g., Z_9H_RVORDER01), and the source client is the PCC number.

5. Click Execute.
An action log is produced.

6. Click Back twice.

The SAP standard layout sets use D (German) as the original language. To modify the copied layout set,
the original language of the set must be changed to the language in which you are working. Continuing
with the example above, we have to change the original language of ZVORDER01 to E.

2

3

4

5 6
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Changing the default language to English is not necessary for the layout sets copied from the PCC – those
layout sets already use English as original language.

1. Enter ZVORDER01 and D in the
Layout Set: Request screen.

2. Click Change.
If you activate the correction and
transport system (CTS), put your
new layout set ZVORDER01 on a
correction request.

3. Choose Utilities → Convert orig.
lang…

4. Enter E for the new language.

5. Click OK.

The new layout set is ready to be
modified in the selected client.

1

2

4

5
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Chapter 4:   Layout Set Elements
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Overview

This section describes the elements that comprise a layout set. To understand the “How-To’s” that are
described later, you will need to first understand certain aspects of SAPscript. For more information on
SAPscript for layout sets, see the R/3 documentation.

A layout set consists of the following components:

Header: General information and default settings

Paragraphs: Font and tab information for paragraphs

Character strings: Font information within a paragraph

Windows: Descriptions of areas on the pages

Pages: Page names with page flow information

Page windows: Position and size of the windows on the pages

Documentation: Technical documentation about the layout set elements

Where to Begin

1. Choose Tools → Word processing →
Layout set.

1
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2. Access the components by
specifying the layout set name and
a language in the Layout Set:
Request screen.

3. Under Sub-objects, select a
component option. (In our
example, we chose Header).

4. Click Display or Change.

5. Each component allows you to
jump to other components without
backing out to this screen. For
example, to jump to the layout set
windows from the header of a
layout set, click Windows.

3

4

5 555 5

2
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Layout Set Components

Header
The Header consists of either administrative information for the layout set or default settings that can be
overridden in other parts of the set.

The two elements important to your customizations are the font and the page format. Except for checks,
the page format for the U.S. and Canada is “Letter” and for Australia is “DINA4”. The only purpose of the
values at ‘Lines per inch’ and ‘Characters/inch’ is to convert the measures specified in lines and characters
to absolute values. Do not touch these two values because all the tabs and window coordinates will be
readjusted. The font will be discussed later in this section.

Paragraph
A Paragraph contains all the information needed to format text. In layout sets, not all of the formatting
possibilities are used, because most layout set paragraphs consist of only a line or a word.

Font and tabs are important for paragraphs. If no font is specified, then the default font from the layout set
header will be used. To create columns for outputting line items of a document, specify a list of tabs.

If a paragraph uses a small font, set the line spacing to less than one line.
Please ensure that the printer can print more than six lines per inch.

The following two pictures illustrate a
paragraph definition.
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Tab positions are specified as the
number of characters from the left. The
system uses the “Characters per inch”
value in the header to convert the
number of characters into an absolute
value. For this conversion, the font size
does not matter.

Character Strings
A Character String overrides paragraph settings for specific words in a paragraph. For example, you might
want to italicize a single word and not the entire paragraph.

To apply character strings within a paragraph, turn on the settings for the
character string by enclosing the character string name in  “< >”  before the
specific text. To return to the standard paragraphs settings, insert “</>”  at
the end of the specific text.

For example: <B>These words will be bold</>
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The only important information, which
is defined in the standard view of
character strings, is the barcode. For
barcode printing, choose from a list of
available barcodes.

Click Font to get to the font definition
of a character string.

Radio buttons can be used to underline
the typeface, to italicize it, or to make it
bold.

Retain means that bold, italics, or
underlining settings are retained from
the paragraph. If a character string has
no specified font, then the paragraph
font is used.

In the screenshot at the right, the
character string B changes the format
to bold, while the settings for Italics
and Underline are retained from the
paragraph.
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Windows
A Window contains the SAPscript text, which can be structured into blocks called “text elements,” and the
to-be-printed variables. There is one special window, MAIN, that contains the output of the document line
items.

1. From the list of windows, click Text
elements to jump into the window
text.

Except for MAIN, the window type can be either variable (VAR) or constant (CONST). SAPscript does not
distinguish between the two window types, although these types are mentioned in the SAPscript
documentation.

1
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This is what the documentation says
on window types:

Variable window content is
regenerated on every new page. The
content of a constant window is
generated once at the beginning and
is then printed on every page.

This means that, for better
performance, windows that contain
different information on different
pages must be VAR and all others
must be CONST. The contents of the
window are defined in the SAPscript
editor.

1. The first two-character column
contains the format of the text.

2. The second column contains the
text of the window.

The lines of the text editor can contain up to 132 characters but only displays
72 characters. The text editor indicates additional characters with a “>” at the
end of the line. Click Shift+F8 to switch between the first and the last 72
characters of the editor lines.

3. A format can be either
paragraphs or special characters.

 The following are used as special characters in layout sets:
* Default paragraph of the window or the header
/: Command line for SAPscript commands
/* Comment line
/E Text element

1 2

3
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SAPscript offers the option of printing only parts of a window. For example,
a part is printed only if customizing variables are set in a particular way. In
this case, text elements are used. A text element always starts with /E <name
of text element> and continues to the next text element, or to the end of the
editor, whichever comes first. The print program controls whether a text
element is printed and the order in which the elements are printed.

Paragraph tabs are specified by ‘,,’ within the text editor.

If you specify more tabs than those defined for the paragraph, the default tab
stop of the header is used. To jump to the contents of a window, select the
window by double-clicking on its name, and clicking Text elements.

A variable name consists of the name of a DDIC structure, a hyphen, and the field name. All variable
names must also be enclosed in ampersands (&). If you want to output variables, you may format them.
This step is necessary if you do not want the standard formatting of the variables coming from the
“Dictionary.”

The most common formatting options are:

• Truncating the variable length

• Outputting the variable with an offset

• Specifying the number of decimals

• Omitting leading zeros

Syntax:

&table-field(n)& prints the first n characters of the variable.

&table-field+m& prints the rest of the variable after the first m characters.

&table-field(.l)& prints the variable with l decimals.

&table-field(Z)& omits the leading zeros

Only combinations of the first three formatting options are allowed. The syntax for all three formatting
options together is:

&table-field+m(n.l)&

Please see the chapter SAPscript Control Commands for a detailed list of formatting options.
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Pages
Pages are not important for layout sets.
Normally, you will not have to jump to
pages while modifying layout sets.

Page Windows
If you select Page windows, a list of all the windows on the page appears, with coordinates defined by the
upper left-hand corner, the width and the height. It is possible to jump from this list to the window text
elements.

All of the windows that appear on pages must be first defined in Windows
and then added to the page windows.
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If you select Page windows, the
windows of page FIRST are displayed.
To access the page windows of another
page, simply overwrite FIRST with
NEXT and click Enter.

Documentation
Storing technical documentation for layout sets is a new feature of SAPscript in Release 3.1H. Although
most of the layout sets are documented in Release 4.0A, we recommend that you check to see if layout set
documentation exists.
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From Release 3.1H on, there will be
useful technical information here. The
layout set, the usage of the page
windows, and its text elements are
described. If you want to modify
layout sets, look for information about
the layout set variables and when the
print program fills the variables.



Layout Set Elements
Layout Set Components

4–12 © 1998 SAP Labs, Inc.



An Easy Guide to Complicated Modifications
Overview

© 1998 SAP Labs, Inc. 5–1

Chapter 5:   An Easy Guide to Complicated Modifications
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Overview

This chapter shows you how to modify layout sets from copying a provided layout set to adding bar codes
and logos. Remember that some layout sets in Release 3.1H may have technical documentation. See the
end of chapter 4 to learn how to access this documentation.

To make the next system upgrade easier and smoother, do not modify the
standard layout sets or the layout sets from the disk; copy these sets and
modify these copies.
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Copying a Layout Set

Layout sets must be copied before changes are made. The following example shows how to copy the layout
set for a sales order confirmation.

1. Choose Tools  → Word processing  →
Layout set.

2. Enter the new layout set name.
(This name is same as the old name
except, that the first character is
replaced with a Z.) In our example,
the new name for the sales order
confirmation is Z_9H_RVORDER01.

The new name of a layout set has to be
in the name range for customer objects,
so it must begin with Y or Z.

3. Enter E.

4. Click Create.

5. Click Enter to accept the message in
the following pop-up window.

1

2
3

4
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6. Enter Sales Order Confirmation
in Description field.

7. Choose Layout set  →  Copy from ...

8. Enter J_9H_RVORDER01.

9. Click OK if the information in the
pop-up window is correct.

10. Click Save.

If your system is connected to the
Correction and Transport System
(CTS), the new layout set must be
written on a correction request. (The
instructions to write a correction
request are not included in this guide.)

11. Choose Layout set  →  Activate.

It is not necessary to click Save in step
10, because the layout set is saved
during activation in step 11.

6
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To test the layout set during sales order customizing, specify that layout set
Z_9H_RVORDER01 should be used to print all sales order confirmations.
See chapter Printout-related Customizing of the Applications.

Test Print of Layout Sets

An easy way to check layout set changes is to use the layout set’s test print functionality. SAPscript
replaces the variables in each layout set with character strings of x with the defined length. All page
windows, except MAIN, are printed as they appear on the actual output. MAIN has a list of all defined text
elements. Test printing layout sets is a quick way to check changes without printing the documents, and
without disturbing the productive print process with unconfirmed layout set modifications.

1. Choose Tools → Word processing →
Layout set.

2. Enter J_9H_RVORDER01.

3. Choose Utilities → Test print.

1

2

3
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4. Enter LP01.

5. Click Print.

Moving a Page Window

Task: To move the INFO window on page FIRST of the layout set, Z_9H_RVORDER01, one line up
and one character to the left.

1. Choose Tools  →  Word processing
→  Layout set.

1

4
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2. Enter Z_9H_RVORDER01 and E.

3. Select Page windows.

4. Click Change.

5. FIRST is automatically selected.

6. Select INFO by double-clicking on
the window’s name.

7. Enter the coordinates at the bottom
of the screen.

The window coordinates are located in
the bottom of the screen. The upper
left-hand corner is based on Left margin
and Upper margin. The width and
height is based on Window width and
Window height. Make sure that the
vertical measure is LN (lines) and that
the horizontal measure is CH
(characters).

2
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8. To move the window up one line
and one character to the left,
overwrite the left margin with
42.00 CH and the upper margin
with 10.00 LN.

9. To activate the changes, choose
Layout set  →  Activate.

Moving a Field

Task: Move the text that appears on the layout set output.

Moving text can be divided into the following cases:

• If it is the only text in a window then move the window.

• If it is positioned with a tab then move the tab.

• If it has to be moved vertically then insert or delete an empty line.

8

9
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Moving a Tab
Task: In the table header of line items for an order confirmation, move Material one character to the

right.

In this example, we describe the movement of one word in the table header
of line items in a sales order. The complete task would be to also move the
corresponding line items variable to match the columns for both the table
header and line items.

1. To see how Material is printed,
choose Tools  →  Word processing  →
Layout set.

2. Enter Z_9H_RVORDER01 and E.

3. Select Page windows.

4. Click Change.

1
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5. Double click on  MAIN.

6. Click Text elements.

7. Scroll down until you see /E
ITEM_HEADER.

8. The paragraph where Material is
printed is IL.

9. Material is printed after the first tab,
which is represented by a set of
double commas. To move the word
one character to the right, this tab
has to also be moved one character
to the right.

10. Go to the paragraphs’ definition via
the Back and Paragraphs buttons.

5
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11. Double click on IL.

The paragraph will be highlighted
after selection.

12. Click Tabs.

13. The first tab is positioned seven
characters from the left, and the
text that belongs to this tab is left
justified.

To move Material one character to
the right, increase the first tab by
one and overwrite 7.00 with 8.00.

11

12
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14. To activate the changes, choose
Layout set → Activate.

Inserting or Deleting a Line
Task: On an order confirmation, insert a blank line between the words Ship-to address and the address.

Using page window INFO1, the ship-to
address is printed on page FIRST.

1. To access the text editor of this
window, choose Tools → Word
processing → Layout set.

2. Enter Z_9H_RVORDER01 and E.

3. Select Page windows.

4. Click Change.

2

3

4
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5. Double click on INFO1.

INFO1 should be highlighted after
selection.

6. Click Text elements.

7. To insert an empty line, position
the cursor where you want to insert
this line. In our example, it is at the
end of /  <s>Ship-to ddress</>

8. Click Enter.

5
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Note that the ship-to address is printed only if the variable for the ship-
to country, VBDKA-LAND1, is filled. Character string s is used to print
Ship-to address.

To use a character string in a paragraph, this string has to be turned on
and off. To turn a character string on, place < > around the string name.
For example, <s> switches the character string S on. To turn the
character string off, enter   </>.

The asterisk in the format column of
the new line indicates that the previous
paragraph should be re-used.

9. Click Back to exit the text editor.

10. Choose Layout set  →  Activate to
activate the changes.

To delete a line, go to the window’s text editor and overwrite the line (including the format column) using
spaces.

After overwriting with spaces, do not click Enter, because it will insert an
empty line. To exit editor, click Back.

9
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To delete an entire block of lines, mark the block by double clicking on the format columns of the first and
last lines. Click Delete. The cut-and-paste functionality for example, moves the block to another window.

Removing a Field

We just discussed removing a field by removing a line in the window. Another example of removing a
field occurs when a field is with other fields that are not separated by tabs. In this case, delete the field by
using the Delete key in the text editor.

Removing a field from a line item table is more complicated. For example, to remove the item number from
a sales order confirmation, first remove Item and move Material and Description. This procedure has to be
repeated for the item number’s variable. The variables for the material number and description also have
to be moved.

1. Choose Tools →  Word processing  →
Layout set.

2. Enter Z_9H_RVORDER01 and E.

3. Select Page windows.

4. Click Change.

MAIN is already selected, because
it is highlighted.

1

2
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5. Click Text elements and scroll down
until you see /E ITEM_HEADER.

6. Delete Item and the two commas
that represent the first tab.

7. In ITEM_LINE, delete &VBDPA-
POSNR& (the variable for the item
number) and the first tab (the two
commas).

Since one tab has been deleted, adjust
the tabs for IL.

8. To do this, click Back to exit Text
editor.

9. Click Paragraphs to proceed to the
IL tabs.

6
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10. Double click on IL and click Tabs in
the lower right-hand corner of the
screen.

11. Delete the first tab and move the
second tab to the left. Because the
first tab was positioned seven
characters from the left, the second
tab has to be moved seven
characters to the left.

12. Delete the first tab by overwriting
all three columns with blanks.

13. Adjust the second tab by
overwriting 26 with 19 (26-7).

10
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14. To activate the changes, choose
Layout set  →  Activate.

Adding a New Field

Adding a new field can be a difficult task because not every field defined in the Data Dictionary can be
printed. Only fields of special Dictionary structures can be used.

All R/3 documents have at least two structures defined in the Data
Dictionary. These structures are used to print the header and line item
document data. The fields of these structures can be used as variables in the
layout set.

Some of the structures have user-exits for additional to-be-printed fields.
And, although it is sometimes enough to add the user-exit field to the
structure, some ABAP/4 programming maybe necessary.

14
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Before adding a new field, find out the field’s name. Here is the procedure for Sales Office, which you can
find on the Standard Order: Header - Business Data - Sales Details screen.

1. Open the Standard Order: Header -
Business Data - Sales Details screen.

2. Place the cursor on the field for
which you want to find the name.
In this example, it is Sales office.

3. Click F1 or Help.

4. A pop-up Help window appears
with information about the field.

5. Click Technical info.

1
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6. The field’s name is located in Field
name. In our example, it is VKBUR.

The next step is to decide whether the field belongs to the document header or the document items. In
our example, the sales office belongs to the header because it was located on the Sales details section of
the Sales Order Header. The next task is to find out if the field is designated as output. A field is flagged
as output only if it is included in a structure in the following table.

This table lists structures used to print header and item data:

Header Data Dictionary Structure

Sales Order Confirmation VBDKA

Packing List VBDKL

Picking List VBLKK

Invoice VBDKR

Purchase Order EKKO

Pre-numbered Check REGUH

PP Goods Issue Slip CAUFVD

PP Pick List CAUFVD

PP Confirmation Slip CAUFVD

PP Time Ticket CAUFVD

PP Goods Receipt List CAUFVD

PP Operations Control Ticket CAUFVD

PP Object List CAUFVD

PP Kanban Card KARTE

6
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Item Data Dictionary Structure

Sales Order Confirmation VBDPA

Packing List VBDPL

Picking List VBLKP

Invoice VBDPR

Purchase Order EKPO

Prenumbered Check REGUP

PP Goods Issue Slip RESBD

PP Pick List RESBD

PP Confirmation Slip AFVGD

PP Time Ticket AFVGD

PP Goods Receipt List RESBD (In addition
for co-products with
settlement: AFPOD)

PP Operations Control Ticket AFVGD

PP Object List AFVGD

PP Kanban Card KARTE

The Prenumbered Check print program also provides, REGUD, a structure for bank data.

To find out if VKBUR is included in VBDKA used to print sales order confirmation header data.

1. From the initial SAP screen, choose
Tools  →  ABAP/4 Workbench.

2. Click ABAP/4 Dictionary.

1

2
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3. Enter VBDKA.

4. Click Display.

The result is the list of all fields in
VBDKA.

5. Click Find.

6. Enter VKBUR.

7. Click Enter.

3
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The cursor will either be positioned on the field name or the message No appropriate field name found
appears. If the field name was found, follow the steps below. If the field name was not found, first proceed
to the section titled, Adding a new field to the print structure, then return to this page and follow the steps
below.

When the variable name is included, do the following, assuming that the field should be included at the
bottom of the INFO window:

1. From the initial R/3 screen, choose
Tools  →  Word processing  → Layout
set.

2. Enter Z_9H_RVORDER01 and E.

3. Select Page windows.

4. Click Change.

1
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5. Double click on INFO.

Note that the window is
highlighted after selection.

6. Click Text elements.

Insert the variable at the bottom of the
window. Click Page down to scroll to
this position.

7. Scroll down until you see only one
line.

8. Position the cursor at the end of
this line.

9. Click Enter to create a new line.

5
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10. Enter <s>Sales Office</> (the
header of the new variable).

11. Click Enter.

After creating the new line, the
paragraph is automatically set to AS.
This is the last paragraph used in this
window.

All headers are printed in a smaller
font, defined with the character string
S. Therefore, Sales Office has to be
enclosed in <s> and </>.

12. Enter &VBDKA-VKBUR& (the variable
name enclosed in ampersands).

A variable name is the name of the
structure followed by a hyphen (“-”)
and the field name. Variable names
must be enclosed in ampersands.

13. Click Back.

11
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14. Choose Layout set  →  Activate.

Adding a Field to the Print Structure

These steps only apply to SD documents. No steps exist for other documents! However, the
structures for the other documents already contain most, if not all, of the required fields.

This section provides directions to add a new field to a print structure. If a field is not included in a print
structure, follow these steps. One example of a field not in the sales order header print structure is XBLNR.
Please refer to the Standard Order: Header - Business Data - Billing Details screen. It is the field Reference No. in
the Accounting frame.

The following table shows the names of the structures to which field names can be added:

Document Structure

Sales Order Header VBDKAZ

Sales Order Item VBDPAZ

Packing List Header VBDKLZ

Packing List Item VBDPLZ

Picking List Header VBLKKZ

Picking List Item VBLKPZ

Invoice Header VBDKRZ

Invoice Item VBDPRZ

SD structures include sub-structures. By adding a field to a sub-structure
and activating it, a field is automatically added to the structure.

These sub-structures are treated as a user exit, and SAP does not overwrite them during an upgrade.

In the example above, XBLNR must be added to VBDKAZ.

14
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1. Choose Tools  → ABAP/4
Workbench.

2. Click ABAP/4 Dictionary.

3. Enter VBDKAZ.

4. Select Structures.

5. Click Change.

6. Now, a 20-digit access key must be
specified to register the object as
modified. Ask the system
administrator if you do not know
where to get this key.

7. Click Object for repair and specify a
correction number (CTS).

8. When this screen appears, click
Enter.

1
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9. Click New fields.

10. Enter XBLNR.
11. Tab to the next column.
12. Enter XBLNR.

Normally, the field name and the data
element name are the same.

13. Choose Table → Activate.

Now VBDKA-XBLNR is a valid variable that can be added to the layout set. Note that the name of the
structure is still VBDKA, not VBDKAZ.

9
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The next procedure is to find out whether additional ABAP/4 programming is needed to fill the variable
or if the new variable has been automatically filled. When you look up the field name notice the table name
where the field is stored. For XBLNR, the table is VBAK. The following table shows the name of all tables
where no additional ABAP/4 programming is necessary:

Document Tables

Sales Order Header VBAK

Sales Order Item VBAP

Packing List Header LIKP

Packing List Item LIPS

Picking List Header LIKP

Picking List Item LIPS

Invoice Header VBRK

Invoice Item VBRP

If additional ABAP/4 programming is necessary, the following programs have been provided to fill the
variables. (However, this guide does not provide programming instructions.)

Here is the table of user-exit program names:

Document Program

Sales Order V05DZZEN

Packing List V05OZZEN

Picking List V05AZZEN

Invoice V05NZZEN

In the sales order print program, the header data is collected in VBDKA. The item data structure is POS.
Here is an example for a sales order user exit, where data was first selected to be added to the header and
then to be added to the items:

* Select field1 from dbtab1 and put it into newfield1 in vbdka

Select single * from dbtab1 where vbeln = vbdka-vbeln.

If sy-subrc = 0.

  Vbdka-newfield1 = dbtab-field1.

Endif.

* Select field2 from dbtab2 and put it into newfield2 in vbdpa

Loop at pos.

  Select single * from dbtab2 where vbeln = vbdka-vbeln

                              And   posnr = pos-posnr.

  If sy-subrc = 0.
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    Pos-newfield2 = dbtab2-field2.

    Modify pos.

  Endif.

Endloop.

In the packing list print program, the header data is collected in VBDKL. The structure for the item data is
VBDPL_TAB. In the picking list print program, the header data is collected in VBLKK_WA, and the item
data structure is VBLKP_TAB. In the invoice print program, the header data is collected in VBDKR, and the
item data structure is LVBDPR.

Printing a Company Logo

To print a company logo, either include it in the layout set, or include it as a macro on a PCL-5 printer. The
following rules allow you to determine which method is most appropriate for you.

• If you cannot provide your logo in the Baseline TIFF 6.0 format, the company logo should be a macro on
the printer.

Note: Many paint programs support this format.

• If you do not have a PCL-5 printer, include the company logo in the layout set.

• In all other cases, include the company logo in the layout set.

If you followed the directions exactly, and no logo is printed, the format of
the logo file format is probably not Baseline TIFF 6.0. SAPscript does not give
an error message if an incorrect file format is used.

The following procedures are also documented in OSS notes 39031, 18045 and 5995.

Including the Company Logo in the Layout Set
1. Create your company logo with a

graphics program.

2. Save it in the Baseline TIFF 6.0
format.

In our example, the filename is
LOGO.TIF.

3. Choose Tools → ABAP/4 Workbench.

3
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4. Click ABAP/4 Editor.

5. Enter RSTXLDMC.

6. Click Execute.

7. Determine the location of
LOGO.TIF.

4
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Fill out the following report
parameters:

8. Enter the file name with its
location. Note that UNIX file names
are case sensitive.

9. Choose and enter a Type choice:
BMON for a black and white

raster image or
BCOL for a color raster image

with up to 256 colors.

Use BMON for monochrome printers
because these printers normally do
not perform a gray-level
conversion.

10. Enter ZHEX-MACRO-LOGO in Text
name.

11. Click Execute.

The upload may take a while so be patient. The result should be a protocol with a saved-successfully
message at the end.

The result is a standard text. To display the standard text:

1. Choose Tools  →  Word processing  →  Standard text
2. Enter ZHEX-MACRO-LOGO
3. Click Display

For additional documentation, access report RSTXLDMC:

1. Choose Tools → ABAP/4 Workbench

2. Click ABAP/4 Editor

3. Enter RSTXLDMC

4. Select Documentation

5. Click Display

8
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Including the Logo in the Layout Set
To illustrate the procedure, consider Z_9H_RVORDER01 for sales order confirmation.

First, create a new window for the logo.

1. Choose Tools  →  Word processing
→  Layout set.

2. Enter Z_9H_RVORDER01 and E.

3. Select Windows.

4. Click Change.

5. Choose Edit → Create element...

6. Enter LOGO in the Window and
Logo in Description.

7. Click OK.

2
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8. Overwrite VAR with CONST.

9. Click Text elements.

10. Enter INLCUDE ZHEX-MACRO-LOGO
OBJECT TEXT ID ST in the first
line.

11. Click Back.

8
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12. Click Page windows.

 Add the new window to the page
windows of the pages.

13. Choose Edit → Create element...

13

12



An Easy Guide to Complicated Modifications
Printing a Company Logo

© 1998 SAP Labs, Inc. 5–35

14. Position the cursor on LOGO.

15. Click Choose.

Fill out the coordinates of the window
with the logo.

16. Sample coordinates for a logo, to be
positioned in the top left-hand
corner of a page, are:

Left margin: 7 CH
Upper margin:  0 LN
Window width: 71 CH
Window height: 8 LN

Horizontal coordinates must be
specified in CH and vertical
coordinates in LN.

17. Repeat steps 13 to 15 for every page
of the layout set. Position the cursor
on the field with the page name
and click F4.

18. Position the cursor on each page
and click Enter to repeat steps 13 to
15.
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The coordinates of LOGO are taken from FIRST onto the other pages. Since
you do not have to repeatedly overwrite the window coordinates, step 16
does need not to be repeated.

19. Choose Layout set → Activate.

The Logo as a Macro on a PCL-5 Printer
The following procedure only works on a PCL-5 printer. In R/3, the printer types are either the following
or a copy of the following:

• HPLJIIID

• HPLJ4

• HPLJ5SI

• HPLJMI

• IBMAFP

• IBMAFP3

• IBMEFP

• IBMEFP3

• LX4039

• SNI20XX8

Various third-parties offer logos as a PCL-5 macro and can instruct you on how to bring the logo to the
printer.

The macro file can be loaded on the printer by printing the file once from the operating
system level (for example UNIX command lp). The disadvantage to this step is that macros
are lost when you turn off the printer. To avoid this, load the macro onto a Flash-Memory
cartridge.

19
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To modify a printer type, first copy a standard printer type.

1. To determine the device type to
use, choose Tools  → Administration.

2. Choose Spool  →  Spool
administration.

3. Select Output devices.

4. Click Display.

5. Behind the four-character printer
name, find the device-type name.
Let us assume the device-type
name is HPLJ4 (HP Laserjet 4 series
PCL-5).

6. Click Back and return to the Spool
administration screen.

1
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7. Choose Utilities  →  Copy device
type.

8. Enter HPLJ4.

9. In to device type, enter a name for a
copy of the device type.

The name must begin with a Y or Z
(for example ZHPLJ4).

10. Click Execute.

11. Click Yes to confirm all the pop-up
windows.

12. Click Back and return to the initial
Spool Administration screen.

Now, define a print control for your macro. In our example, the macro has macro id of 100. The macro id,
which is set when you bring the macro to the printer, must be between 100 and 999. Please get your id
from your system administrator.

7
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1. Select Device print control.

2. Click Change.

3. Scroll down until you see ZHPLJ4.

4. Double click on the device type you
have created.

1
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5. Overwrite the first line with ZM100
(the new print control) and the
control character sequence
1B2666313030793358.

The control character sequence
contains the macro id in hexadecimal
representation. The sequence is
1B2666...793358, where the three dots
are the hexadecimal representations of
the macro id letters. If the macro id is
100, the three dots will be 313030. In
general: The hexadecimal
representations for 0 to 9 are 30 to 39.

6. Click Back.

7. Click Yes.

8. Click Back twice.

Including the Print Control in the Layout Set
To illustrate the procedure, consider Z_9H_RVORDER01 for sales order confirmation.

First we have to create a new window
for the logo.

1. Choose Tools  →  Word processing
→  Layout set.

1
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2. Enter Z_9H_RVORDER01 and E.

3. Select Windows.

4. Click Change.

5. Choose Edit  →  Create element...

6. Enter LOGO in Window and Logo in
Description.

7. Click OK.
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8. Enter CONST to overwrite VAR.

9. Click Text elements.

10. Enter /: PRINT-CONTROL ZM100.

11. Click Back.

8
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12. Click Page windows.

 Add the new window to the page
windows of the pages.

13. Choose Edit → Create element...

12
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14. Place the cursor on LOGO.

15. Click Choose.

Enter the coordinates of the window
with the logo on the following
screen.

16. Sample coordinates for a logo to be
positioned in the top left-hand
corner of a page are:

Left margin: 7 CH
Upper margin:  0 LN
Window width: 71 CH
Window height: 8 LN

Horizontal coordinates have to be
specified in CH, vertical coordinates in
LN.

17. Repeat steps 13 to 15 for every
layout set page. Position the cursor
on the field with the page name
and click F4.

18. Position the cursor on each page
and click Enter to repeat steps 13 to
15.
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The coordinates of LOGO are taken automatically from FIRST to the other
pages. Since you do not have to repeatedly overwrite the window
coordinates, step 16 does not have to be repeated.

19. Choose Layout set → Activate.

Printing Bar Codes

The work in the SAP System depends on whether you need hardware or software and can become
technical. The easiest way to print bar codes is to use a Kyocera laser printer, because no additional
hardware or software is needed.  You just need to add the bar code to the layout set.

With a HP laser printer, the solution is quite as simple, it is almost “plug-and-play.” Add the JetCAPS
BARSIMM to a HP Laserjet 4 or 5 printer and add the bar code to the layout set. Most other solutions
require more work. To keep bar code printing easy, this guide covers only the Kyocera and HP laser
printers. For HP laser printers, insert the SIMM into your HP Laserjet 4 or 5 and make sure that your
printer is an HPLJ4 in R/3. If you do not know your printer’s type, ask your system administrator.

With the SIMM, you receive a list of print controls that tell you how to
switch the bar codes on and off. These print controls are already defined for
the HPLJ4.

The next step is to define the bar code in the layout set. Assume that you want to print the material
numbers on a sales order confirmation as a “3 of 9” bar code with check digit.

1. Choose Tools  →  Word processing
→  Layout set.

1
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2. Enter Z_9H_RVORDER01 and E.

3. Select Char.strings.

4. Click Change.

5. Choose Edit  →  Create element…

6. Enter up to two characters in
Charact.strg and a description (for
example, B3 and Bar code 3 of 9
w/check).
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7. Click OK.

8. Place the cursor in Bar code and
click F4 to choose from the
available bar codes.

9. Double-click on the appropriate bar
code. (In our example, we double-
click BC_CD39C.)

The bar code is now defined and can
be used. We have to go to the text
elements of MAIN and print the
material number as the bar code in a
separate line.

10. Click Page windows.

8
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11. Click Text elements.

12. Scroll down until you see /E
ITEM_LINE.

13. Place the cursor at the end of the
first line under /E ITEM_LINE

14. Click Enter to create a new line.

11
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15. Enter,,<B3>&VBDPA-MATNR&</> on
this new line.

The two commas, for the first tab, position the bar code under the material
number. With <B3>, change to the character string B3, which defines the bar
code. </> ends the character string and returns to IL.

Some of the bar codes are higher than one line, which may cause the
previous lines to overlap. To avoid overlapping, add blank lines before the
line with the bar code. Use such a paragraph for this blank line, so that the
blank lines are not compressed. To check the paragraph setting, go to the
paragraph’s standard attributes and ensure that the No blank lines checkbox
is de-selected.

In our example, notice the bar code, which reserves space for the entire
material number field. (This field is 18 characters long.) If you do not use all
18 characters and do not want to waste space, delimit the field length by
using the output length formatting option. The text editor line is
,,<B3>&VBDPA-MATNR(8)&</>

In a numerical bar code, some scanners cannot read special characters. For
these scanners, omit the special characters inserted by SAPscript during
formatting. An example of a special character is the delimiter for
“Thousands” that is used for some numerical fields. See chapter 7 for more
information on formatting options.
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15. Click Back.

16. Choose Layout set   →  Activate.

Adding a Box with Shading

Task: On the sales order confirmation output, draw a box around the ship-to address and shade Ship-
to address.

In this task, we want to have a box around an entire page window and
shade the first line of this page window.

Boxes, lines, and shading are well documented in R/3. To access this
documentation, choose Help → R/3 library from any R/3 screen. Click Basis
Components, System Administration, Style & Layout Set Maintenance, Styles and
Layout Sets: Components and Techniques and Boxes, Lines, and Shading.
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1. To access Z_9H_RVORDER01,
choose Tools  →  Word processing
→  Layout set.

2. Enter Z_9H_RVORDER01 and E.

3. Select Page windows.

4. Click Change.

1
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5. Double-click on INFO1.

Make sure that it is highlighted
after selection.

6. Click Text elements.

If the variable VBDKA-LAND1_WE is
filled, the window is only output.
Therefore, the box and shading should
be printed only if this variable is filled.
(We inserted the box and shading
commands between the first and
second line of the text editor).

5
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1. Place the cursor at the end of the
first line.

2. Click Enter.

3. In the format column, replace * in
with /:

4. Enter POSITION XORIGIN ’-0.5’
CH YORIGIN ’-0.25’ LN.

This command positions the cursor a
half character and a quarter line off the
page window’s upper left corner. This
is the starting point for the next
command, which will be the sizing of
the box. Place the cursor off the page
window to avoid overwriting the
contents of the window with the box.

11. Place the cursor at the end of the
previously entered line and click
Enter.

This inserts an empty line.

7

9 10

8

11



An Easy Guide to Complicated Modifications
Adding a Box with Shading

5–54 © 1998 SAP Labs, Inc.

12. In the format column, replace the *
with /:

13. Enter SIZE WIDTH +1 CH
HEIGHT +0.5 LN.

14. Place the cursor at the end of the
previously entered line and click
Enter.

This inserts an empty line.

The command defines a window one
character wider and half a line higher
than the page window. The line
inserted in step 13 creates a window,
which overlaps the page window by
half a character on the left and right
side and by a quarter line on the top
and bottom of the window. Size the
box bigger than the page window to
avoid overwriting the contents of the
window with the box.

12 13
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15. Replace the * in the format column
with /:

16. Enter BOX FRAME 10 TW.

The command paints the box in the
previously defined size. The thickness
of the line of the box is specified with
10 twips.

We now have painted the box. Next,
we will shade the first line of the box.

17. Place the cursor at the end of the
line in step 16 and click Enter.

This inserts a blank line.

18. Replace the * in the format column
with /:

19. Enter BOX HEIGHT ’1.5’ LN
INTENSITY 20.

This command shades the first one and
a half lines of the box with an intensity
of 20% gray. Shading more than one
line is necessary because the box
begins a quarter line above the page
window. With a shading level of 1.5
lines, the line, the quarter line above
the page window, and a quarter line
below the text line are shaded.

20. Click Back to exit the text editor.
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21. Choose Layout set  →  Activate.

By default, a box is oriented to the page window coordinates. Therefore,
create a new page window for every box you want to include in the
output. Also, instead of creating boxes for just parts of a window, have
the box fill out the entire page window. If you want to have many boxes
on a page, do not create a page window for every box. The list of page
windows will be intricate.

The following is a simple example of multiple boxes in one page window:

/: POSITION WINDOW

/* First Box

/* POSITION XORIGIN ‘+0’ CH YORIGIN ‘+0’ LN    “This is the default

/: SIZE WIDTH ‘2’CH HEIGHT ‘4’ LN

/: BOX FRAME 4 TW

/* Second Box

/: POSITION XORIGIN ‘+0’ CH YORIGIN ‘+4’ LN

/: SIZE WIDTH ‘10’CH HEIGHT ‘2’ LN

/: BOX FRAME 4 TW

/* Third Box

/: POSITION XORIGIN ‘+10’ CH YORIGIN ‘+2’ LN

/: SIZE WIDTH ‘2’CH HEIGHT ‘2’ LN

/: BOX FRAME 4 TW
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This code will generate three boxes relative to a page window:

                                                                                                                                               Page window boundary

Box 1

+0, +0

2 x 4

Box 2

+0, +4

10 x 2

Box 3

+10, +2

2 x 2
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Overview

This chapter provides an overview of existing third-party solutions, but the list of these solutions is not
complete. There may be other companies that offer comparable output solutions. Although company
representatives have reviewed this content, it may have changed and cannot be guaranteed.
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In general, SAP is not recommending any particular third-party solution. In fact, SAPscript should be used
whenever the functionality of SAPscript is sufficient, because it is the only integrated solution.

The content of the following sections is provided by the third-party vendors and does not necessarily
represent the opinion of SAP.

AFP: FormScape

FormScape is an enterprise output management system that lets you centralize form design and control the
flow of output within your organization from one server, i.e., the program takes the burden of generating
form output off your workstation and places it on one server within your organization. This approach help
you reduce network load because you can print your form without sending the entire formatted print job
across your network wire.

FormScape Components
FormScape consists of three components (FormScape Server, FormScape Developer, and FormScape
Reprint Manager) that work together to provide your forms management solution. FormScape Server traps
data that you want to merge with a form from files on a hard disk or a Windows print queue and processes
the data (e.g., re-maps it, changes fonts, configures overlays, and selects printers and papers). After
FormScape Server finishes processing your data, it routes the final output to a printer, fax, or other archive
device. This component runs as a background process on your Windows NT or Windows 95 machine (on
NT, it also runs as a service), and it doesn’t require user input once you start it. On a Windows 95 machine
the Server can be installed into the startup group for automatic activation or on Windows NT the
installation installs FormScape Server as a service inside of control panel.

You use the FormScape Developer component to configure how the FormScape Server component
captures and processes print jobs. FormScape Developer refers to each unique set of instructions as a
project. When you define a project for FormScape Server, you specify what input it uses, what processes it
performs on the data, and how it designs and redirects your output. Typically the Developer module
would be used on a single machine and manage one or more Server machines across the network.

FormScape Developer consists of a What-You-See-Is-What-You- Get (WYSIWYG) interface for creating
your form layout.

The last component is FormScape Reprint Manager. This component lets you retrieve any document
FormScape Server processes. Once you retrieve the document, you can view it online or print it.

FormScape requires about five megabytes. A small footprint will allow you to quickly migrate to a
different machine in the event of hardware problems.

Cross-Platform Features
FormScape is of a platform-independent nature. You can share FormScape files among PCs, UNIX,
mainframe, and midrange systems through third-party, interconnectivity products.

For example, a user on a SCO UNIX machine running SCO’s Advanced File and Print Server can direct
output data for an invoice to an NT print queue. FormScape will intercept the data, format it, and print the
invoice, complete with graphical formatting.
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The Concept
FormScape Server is driven by a project built with the Developer module. SAP R/3 prints to a “printer”
that is actually a FormScape print queue. FormScape then massages the print stream based upon the rules
in your project and routes the data to its final destination(s). Print can be accommodated by a multitude of
host systems; this includes the AS/400, UNIX line-print daemon, and Windows-based workstations.

FormScape is text driven, so when printing from Windows workstations and Servers, it is best to use a
“generic text” print driver. FormScape is also able to understand PCL. After FormScape acts on your
text/PCL print job, it will apply the filtering rules from your project and send them on to the designated
print queue(s).

The Server module works in three distinct phases:

1. Collection -- Collection is the point where the FormScape Server receives the data by either a printer
queue or via file queue

2. Identification -- this stage determines which set of defined rules should act upon this particular job

3. Reporting -- after Identification, the specific rules and routing procedures are applied to the data and
then sent to the proper printer driver

Netware Server

Invoice Printer
Remote Warehouse Printer

IBM AS/400 UNIX Host

Manual EDI Feed
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Contact:
AFP Technology

Phone: 919-462-1797
Fax: 919-462-1580
Internet: http://www.afptech.com
E-mail: usinfo@afptech.com

Price:
• $4950 per FormScape Server license

• $2250 for a limited two-printer FormScape Server license

• $4950 per FormScape Developer license

• $750 per FormScape Reprint Manager license

HP: Electronic-Forms Solution

Solution
The HP E-Forms solution for SAP R/3 allows SAP customers to create custom electronic forms and merge
them with data from R/3 applications in the
HP LaserJet Printer.

Features
• Extensive forms processing capabilities (bar code, rotated text, watermarks)

• Flexible forms output - print data elements, such as totals anywhere on the page

• Capability to support multiple variations of one form using a single layout set

Ordering Information

See also http://www.hp.com/go/sap_hp

HP Product Number Product Name HP List Price ②

B4177A HP E-Forms SIMM for HP
LaserJet 5 printer

$ 595 (US)

$ 850 (Canada)

B4178A HP E-Forms Software
Developer Kit ①

$ 995 (US)
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$ 1,420 (Canada)

B4179A HP E-Forms Hard Disk
SIMM for LaserJet 5Si

$ 499 (US)

① This software and documentation product is designed to be used with SAP R/3 3.0F/3.1G

②  HP list price of August 20,1997. Pricing is subject of change.  Actual reseller pricing may vary.

System Requirements
HP Product Number Product Name

B4177A HP E-Forms SIMM for HP
LaserJet 5 printer

HP LaserJet 5/5N/5M printer.
Need to order one for every HP
LaserJet 5 printer.

B4178A HP E-Forms Software
Developer Kit ①

The forms design tool requires
an IBM PC or compatible with
80486/Pentium processor with a
minimum of 8MB of RAM,
20MB of free hard disk space,
graphics display monitor,
mouse or other pointing device,
Microsoft Windows 95 or
Windows NT.

B4179A HP E-Forms Hard Disk
SIMM for LaserJet 5si

HP LaserJet 5Si family printer.
Need to order one for every HP
LaserJet 5Si printer.

HP: JetCAPS Bar SIMM

The BARSIMM prints virtually any bar code in any size and direction with processing intelligence for
checksums and test.

Solution
A unique feature is the full EAN 128 set A and the EAN 128 autoswitch, able to analyze incoming data and
to switch dynamically between sets A, B and C within the same bar code. This feature make the HP
LaserJet printer the only standard laser printers that are fully compatible with the new international
shipping label standards UCC/EAN-128 defined by ANSI/MH 10.8 and the ENC/MITL (European
Normalization Committee/Multi-Industry Transport Label).

Features
• Data integrity check

• Checksum calculations

• Text value can be automatically printed
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• Automatic font selection and scaling

Ordering Information
Please refer to the HP Printing Solution web page (http://www.hp.com/go/sap_hp) for more detailed
order information.

Supported HP Printer models
LaserJet 4P, 4MP

LaserJet 4, 4M

LaserJet 4Plus, 4Mplus

LaserJet 5, 5M, 5N

LaserJet 4V, 4MV

LaserJet 4Si, 4Si/MX

LaserJet 5Si, 5Si/MX, LaserJet 5Si/Mopier

SAP R/3 specific information
The R/3 device type HPLJ4 designed for PCL-5 printers supports printing of bar codes using the JetCAPS
BarSIMM. HPLJ4 contains the PCL-5 commands necessary to drive the bar code SIMM and is delivered
with SAP release 3.0. Customers running SAP releases 2.1/2.2 may install this device type into their
systems following R/3 note #8928.

HP: Flash SIMM

Solution
The HP Flash SIMM is capable to store forms, letterheads or any other commonly used document actually
inside the HP printer.

Features
• Integration of graphics, company logos, signatures, etc.

• Update Formats Instantly

• Boost Network Efficiency

• Ensure High Security

• Produce Consistent Documents

• Guaranteed Quality

• Effective Management Control
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Printer Support
• HP LaserJet 4/ 4M

• HP LaserJet 4 Plus/4M Plus

• HP LaserJet 4P/ 4MP

• HP LaserJet 4 Si/ 4SI MX

• HP LaserJet 4V/ 4MV

• HP LaserJet 5P/ 5MP

• HP LaserJet 5/ 5N/ 5M

• HP LaserJet 5Si/ 5Si MX

• HP LaserJet 6P/ 6MP

Management Software Systems Requirements
PC running Windows 3.1 or later, Windows NT, Windows 95 or OS/2.

Order Information
See also http://www.hp.com/go/sap_hp

HP Product Number Product Name HP List Price

C4025A/B/C 1/2/4 MB Flash SIMM
LaserJet 4 family manual

$ 370 (US) / $ 530 (US) /

$ 875 (US)

JetForm: Output Pak

The JetForm Output Pak for SAP allows SAP customers to merge SAP data with a JetForm electronic form
and print it on existing printers.  The JetForm Output Pak for SAP consists of the following products and
services:

JetForm Design

JetForm Design for Microsoft Windows is a WYSIWYG graphical design and development tool for creating
electronic replicas of paper forms.  Customers can design forms that contain company logos, graphics, and
bar codes.  The format of data can be customized.  Tools such as user-defined grids allow for precise
placement of graphics and text.  Full font support is provided, as well as shaded or rotated text.  Forms
developed with JetForm Design are merged with data from SAP applications using JetForm Central.

JetForm Central

JetForm Central is a server-based application, with which customers can deliver presentation-quality forms
output from information stored in the SAP R/3 databases.  JetForm Central’s data merge functions replace
pre-printed forms and unformatted reports. The custom print drivers of JetForm Central guarantee print
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speed three to five times faster than standard operating system print drivers.  JetForm Central is a multi-
platform product that runs under a variety of operating systems.

JetForm Layout Sets for SAP R/3

JetForm has simplified many of the standard SAP R/3 layout sets so that they generate SAP data in the
format that a JetForm form knows how to process. The layout sets included are listed in Table 1.

JetForm Forms for SAP R/3

JetForm has created form files that work with the JetForm layout sets.  These forms can be modified to
meet customer-specific needs such as the addition of company logos.  These forms are listed in Table 1.

Maintenance

One year of premium maintenance for the software.

Consulting

Five days of consulting services for installation of JetForm Central and tailoring of the JetForm forms
(adding the customer’s logo, changing headers and footers, moving fields, etc.).  Travel and living expenses
are not included.

SAP
Module

Layout Set Form

SD RVORDER01 Order Confirmation

SD RVDELNOTE Delivery Note

SD RVINVOICE01 Invoice

SD SD_PACKING_LIST Packing List

SD SD_PICK_SINGLE Picking List

SD SD_LOADING_LIST Loading List

SD SD_CASH_SALE Cash Sale

FI F110_IN_CHECK International Check

FI F140_PAY_CONF_01 Payment Notice Diff.

FI F150_DUNN_01 Dunning Letter

MM MEDRUCK Purchase Order

MM MEDRUCK Request for Quote

Table 1: The JetForm Output Pak Forms and Layout Sets

How it Works
Using the JetForm Output Pak for SAP R/3, the formatting attributes are removed from the layout set and
reside in a form template that is stored on the print server.  Formatting attributes on the form can be
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moved, changed, added, or deleted using the WYSIWYG graphics design tool, JetForm Design. Page sizes,
font types, line spacing, justification, shading, logos, and sizing are all specified within the form itself,
which is independent of the layout set.

The Print Process
The processing steps in printing from R/3 are shown in Figure 1. When a user requests that a form be
printed, the SAP R/3 application program executes an ABAP/4 print program to call the SAPscript
subsystem and open the appropriate layout set. It then passes the application data extracted from the R/3
database to SAPscript by calling elements defined in the layout set. SAPscript is responsible for formatting
the data output stream according to instructions defined in the layout set and specific commands issued by
the print program. The changes JetForm has made to the layout sets allow the SAP R/3 application to
generate the JetForm data stream that JetForm Central knows how to process. The SAPscript subsystem
sends the application data stream to the SAP spool subsystem. The SAP spooler output device type is
specified as a plain ASCII printer, which results in a JetForm data stream being passed to the host spool
system. The corresponding operating system print queue is configured to send the data stream unmodified
to JetForm Central. JetForm Central then performs the data merge function, taking the data from SAP and
placing it on the form created with JetForm Design. Form files and graphic files such as company logos are
stored on the server so that there is no need to download them for each print job. JetForm Central contains
its own print drivers and converts the merged form to the appropriate printer language and sends it to the
specified printer which outputs the document as a printed form.

data

R/3 Application Server

Print Server

JetForm
data stream

SAP R/3
Application

ABAP/4 print
program

SAPscript
subsystem

JetForm
modified
layout set

SAP Spool
Subsystem

Host
Spool

System

JetForm
Central Printer

JetForm
form

Figure 1: SAP R/3 Print Processing Steps Using JetForm

Features
Layout sets are language independent, so only one version needs to be maintained. (Language-dependent
“boilerplate” is stored within the JetForm form file.) Processing time by the SAPscript composer is saved
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because the layout set is simpler. Downloading the forms only once and storing them on the print server
reduces the amount of data that is transferred across the network. Network traffic is reduced because the
spool system data stream sent across the network is significantly smaller than a standard SAP data stream
with embedded formatting information (as small as 1/10th of the typical size).

Features:

• Extensive forms processing capabilities (bar codes, rotated text, watermarks, multi-part forms)

• Print data values anywhere on a form, for instance, “amount due” total at the top rather than bottom of
the page

• JetForm layout sets are language independent

• JetForm data stream sent across the network contains only data, no formatting

• Forms are stored on the print server

• JetForm Central print drivers are 3-5 times faster than operating system print drivers

About JetForm
JetForm Corporation is the global leader in electronic forms automation worldwide, with major offices in
the United States, the UK, France, Germany, Sweden, and the Pacific Rim.

For more information about JetForm, please call 1-800-538-3676 or 1-613-230-3676, or visit their website at
http://www.jetform.com.
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Chapter 7:   Printout-Related Customizing of the Applications
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Overview

Some application customizing is needed to use a non-standard layout set and to achieve certain printing
results that cannot be achieved through modifying the layout set. In this chapter we will cover both types
of customizing entries.
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Accessing the IMG
Since customizing is done through the IMG, we will use this procedure as the starting point for subsequent
sections. All of the IMG-related procedures begin with Access the IMG, and if you do not know how to
access this screen, use the following steps:

1. Choose Tools → Business
Engineering → Customizing.

This screen displays all of the
customizing projects defined in
your system.

2. Choose a customizing project by
double clicking the project name, or
choose Implement. projects → SAP
Reference IMG.

1

2
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3. This Display structure screen shows
the SAP Reference IMG. Depending
on your customizing projects, you
may see fewer topics on your
screen.

A plus sign (+) at the beginning of an IMG line indicates that the topic can be expanded to reveal
additional layers. Expand the IMG layers by placing the cursor on the “+” and clicking the left mouse
button once. A minus sign (-) at the beginning of a line indicates that the topic can be condensed to reveal
the previous layer. We will be using the term Expand in later examples. When you see “Expand Production,”
then Production is expandable by positioning the cursor on the “+” and clicking the left mouse button once.

Customizing in SD

Assigning Print Programs and Layout Sets to Documents
If you copy a layout set to modify it, then inform the system that you want to use this new set for printing.
The following procedure shows how to access the relevant customizing screens. You may also specify
another print program to collect data and printing. However, the print program does not have to be
changed.

3
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1. Access the IMG (see page 2).

2. Expand Sales and Distribution.

3. Expand Basic Functions.

4. Expand Output.

5. Expand Output determination.

6. Expand Process output and forms.

7. Expand Assign forms and programs.

8. Execute Assign sales documents.

In this guide, we considered only the
sales order confirmation output.
However, the standard layout set,
RVORDER01, or the layout set,
J_9H_RVORDER01 (on the disk), can be
used for all the other output types on
this screen.

In the third column of this screen, notice
the output medium (“1” for printer and
“2” for fax).

You can specify the print program and a
layout set for each output type and
medium combination.

2

3

4
5

6

7
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9. Enter your layout set name
(Z_9H_RVORDER01) in each line of
output type and medium you want
to use.

To output inquiry, quotation, sales
order confirmation, contract, and
scheduling agreement confirmation
on the printer or the fax and use
Z_9H_RVORDER01, the screen
should look like this example.

10. Click Save.

If you use the Correction and
Transport System (CTS), specify a
transport request after saving.

11. Click Back.

12. You will now be back in the IMG, the
screen from step 8.

Now we will perform similar customizing for the other SD documents, such as a packing list, a picking list,
and an invoice.

13. For the packing list, execute Assign
shipping documents.

9

10 11

13
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14. The only relevant output type here
is LD00 (Delivery note), which is the
SAP lingo for packing list.

15. To use the printer and the fax as
print media, enter your layout set
name in the two lines of this output
type. (In our example, the layout
set is Z_9H_RVDELNOTE.)

16. Click Save.

If you use the CTS, specify a
transport request after saving.

17. Click Back to return to the screen in
step 8.

18. Execute Assign picking lists.

14 15

16 17

18
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19. The only relevant output type here
is EK00 (Picking list), which uses the
printer as an output medium.

20. Enter your layout set name in the
line of this output type. In our
example, the layout set is
Z_9H_RVPICKSIN.

21. Click Save.

If you use the CTS, specify a
transport request after saving.

22. Click Back to return to the screen in
step 8.

20

19

21 22
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23. Execute Assign customer billing
documents.

24. The only relevant output type here
is RD00 (Invoice).

23

24
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25. To use printer and fax as print
media, enter your layout set name
in the two corresponding lines of
this output type. (In our example,
the layout set is Z_9H_RVINVOICE.)

26. Click Save.

If you use the CTS, specify a
transport request after saving.

27. Click Back to return to the screen in
step 8.

28. Click Back twice to completely exit, or remain at this level and continue from step 7 in the next section.

Specifying Standard Texts for Sender, Header and Footer
Standard texts can be specified to appear on output. The layout sets are configured to print standard texts
as the header, the footer, and the mailing address. This address is printed above the greeting, and the
header and footer are printed at the top and bottom, respectively. Sales order confirmation, packing list,
and invoice use different standard texts for each sales organization, and the picking list uses different
standard texts for each shipping point. Not specifying standard text or if the specified standard texts do
not exist, does not result in an error.

25

26 27
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1. Access the IMG (see page 2).

2. Expand Sales and Distribution.

3. Expand Basic Functions.

4. Expand Output.

5. Expand Output determination.

6. Expand Process output and forms.

7. Execute Assign form texts.

8. To specify the standard texts for
sales order confirmation, packing
list, and invoice, double click
Assign layout set texts per sales
organization.

2

3

4
5

6

7
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Your screen displays the sales
organizations that you have
defined.

Enter the standard text names for:

9. The Address text

10. The Letter header

11. The Footer text

Make sure the text names start with
“Y” or “Z.”

12. Click Save.

If you use the CTS, specify a
transport request after saving.

13. Click Back to return to the pop-up
window in step 8.

9 10 11

12 13
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14. To specify the standard texts for the
picking list, double click Allocate
layout set texts per shipping point.

The screen will display the shipping
points that you defined.

14
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15. Enter the standard text names for
the Address text (sending address),
Letter header, and Footer text.

Make sure the text names start with
“Y” or “Z.”

16. Click Save.

If you use the CTS, specify a
transport request after saving.

17. Click Back.

18. Click Cancel.

19. Click Back twice to completely exit.

15

16 17

15 15
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To define the above-mentioned standard texts:

1. Choose Tools → Word processing →
Standard text.

2. Enter the text name you have
specified in the customizing steps
above.

3. Enter ADRS in Text ID.

In general, the text id is not important.
Since ADRS is used in the layout sets, it
is also easier to use this id here. If you
use another text id, you need to change
the corresponding command line in the
text editor of the layout sets.

4. Click Create/change.

5. After editing, save your changes.

1

2
3

4
5
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Marking Pricing Conditions to Appear on Output
Pricing conditions can be marked to appear on output, either on the item level or as a sum. In customizing,
you can specify whether pricing conditions should appear:

• After each item

• As a sum at the end of all the items

• Or not appear on the output

1. Access IMG (see page 2).

2. Expand Sales and Distribution.

3. Expand Basic Functions.

4. Expand Pricing.

5. Expand Pricing control.

6. Execute Define and assign pricing
procedures.

7. Double click Maintain pricing
procedure.

1

2

3
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Repeat the following steps for
every relevant pricing procedure:

8. Click the box in front of a pricing
procedure.

9. Click the icon in front of Control.

10. In Print line column, press the space
bar if:

• The pricing condition does not
appear on the output.

• Enter X if it appears for every
item.

• Enter S if it appears as a sum.

11. Click Back to return to step 8 for
every relevant pricing procedure.

8

9

10

11
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12. When you are ready, click Save.

13. Click Back.

14. Click Cancel.

15. Click Back twice to return to the
initial screen.

Customizing in MM

Assigning Print Programs and Layout Sets to Documents
If you have copied a layout set to modify it, inform the system that you want to use this new layout set for
printing. The following procedure shows how to access the relevant customizing screens. A print program
to collect data and printing can also be specified. However, the print program does not need to be changed.

12 13
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1. Access IMG (see page 2).

2. Expand Materials Management.

3. Expand Purchasing.

4. Expand Messages.

5. Expand Layout sets for messages.

6. Execute Customize/assign layout set
for purchase order.

7. Double click Output: Assign
processing programs / layout set.

4

5

6

7
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NEU is the output type for the
purchase order.

In the third column of this screen,
notice the output medium (“1” for
printer and “2” for fax).

Specify the print program and a layout
set for each combination of output type
and medium.

8. Enter the layout set name in every
line of output type and medium
you want to use.

In this case, we want to send
output to both printer and fax and
use the layout set Z_9H_MEDRUCK.

9. Click Save.

If you use the CTS, specify a
transport request after saving.

10. Click Back.

8

9 10
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11. Click Cancel.

You will now be back on the IMG.

12. Either click Back twice to completely exit, or remain at this level and proceed with step 5 in the next
section.

11
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Marking Document Texts for Printing
The text from the purchase order and the header and item levels can be selected to appear on the output.
Also, if the material is included in the item, all material texts can be selected to appear on the output at
item level of the purchase order.

1. Access the IMG (see page 2).

2. Expand Materials Management.

3. Expand Purchasing.

4. Expand Messages.

5. Expand Texts for Messages.

6. Execute Define texts for purchase
order.

7. Double click C MM-PUR Document
Printout: Purchase Order.

4
5

6

7

1



Printout-Related Customizing of the Applications
Customizing in MM

7–22 © 1998 SAP Labs, Inc.

Header texts

1. Click Texts for document header.

2. On the Change View “Messages:
Header Texts”: Overview screen,
notice the texts selected to appear
in the output. These texts are a
subset of all the texts defined on
header level of the purchase order.

3. The most important lines are those
with document type NB (Standard
PO). The important operations are
“1”(New purchase order) and “2”
(Changed purchase order).

Texts printed on the header level
can come from either the purchase
order header or can be standard
texts. If they come from the
purchase order header, then EKKO
is object and the header text id is id.
If they are standard texts, then
TEXT is object and ST is id.

If you want more texts on the
output, insert new lines.

4. Click New entries.

1

2
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All of the fields have to be filled out
without clicking Enter in between.
After all the information has been
entered, click Save without clicking
Enter.

If you accidentally click Enter, click
Back to exit from the procedure,
without saving, and begin again. If you
click Enter and save your entries, you
will get empty customizing entries.

5. Enter a print operation (1 for New
purchase order and 2 for Changed
purchase order).

6. Enter NB (Standard purchase order) in the purchasing document type field.

7. Enter EKKO (Purchasing document header texts) in the text object field or TEXT for a standard text.

8. Enter F02 (Header note) in the text id field or ST for a standard text.

9. After Print sequence, enter the number that determines the sequence in which the text is printed.

The numbers you enter may not be used more than once; but you are not
required to enter numbers in sequence. For example, the following
sequences are valid:

• “1, 3, 4, 6, and 8”
• “1, 2, 3, 4, and 5”
• “3, 5, 6, and 9”

10. To print standard texts compared to texts, from the purchase order header, enter the standard text
name in Text key.

11. Select Print title to print the text title on the text. Otherwise the text is printed without a title.

12. Click Save. If you use the CTS, specify a transport request after saving.

13. Click Back.

14. Repeat steps 4-13 for every new text that you want on the output.

5
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If you do not want some texts to be
output, delete them.

15. Select the box in the beginning of
those lines that you want to delete.

16. Click Delete.

To double check the print sequence,
perform the following steps for all
texts:

17. Double click the texts you want on
the output.

15

16
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18. In Print sequence field, enter the
number that determines the
sequence in which the text is
printed.

The numbers you enter may not be
used more than once; but you are not
required to enter numbers in sequence.
For example, the following sequences
are valid:

• “1, 3, 4, 6, and 8”
• “1, 2, 3, 4, and 5”
• “3, 5, 6, and 9”

19. To print standard texts compared
to texts from the purchase order
header, enter the standard text
name in Text key.

20. Select Print title to print the text
title at the top of the text.
Otherwise the text is printed
without title.

21. Click Save. If you use the CTS, specify a transport request after saving.

22. Click Back to return to the text overview screen.

23. Repeat steps 17 to 22 for every text that should appear on the output.

24. When you are finished, click Back.

20

18
19

21 22



Printout-Related Customizing of the Applications
Customizing in MM

7–26 © 1998 SAP Labs, Inc.

Item texts

1. Click Texts for document item.

2. On the Change View “Messages,
Entry Sheet”: Overview screen,
notice the texts you selected to
appear on the output. The texts are
a subset of all the texts defined at
the item level of the purchase
order.

3. The most important lines are those
with NB (Standard PO).

Important operations are “1” (New
purchase order) and “2” (Changed
purchase order). The output texts can
be distinguished by item categories
in the “I” column.

Possible item categories could be:

• Standard items

• Consignment items

• Subcontracting items

• Items for unknown material

• Third-party items

• Text items

• Stock transfer items

• Material group items

• Service items

1
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Texts printed on item level can come from a various number of objects. You can find all these objects by
clicking F4 in the Object column. The most important objects are:

• EKPO (purchase order items)

• MATERIAL (materials)

• EINE (purchasing info records)

• VBBP (sales order items in case of a third-party item)

• ASMD (service master record)

• ESLL (services)

• TEXT (standard texts)

If you want more texts on the output, insert new lines.

4. Click New entries.

Enter information in the fields without
clicking Enter. When you finish, click
Save, without clicking Enter.

If you accidentally click Enter, click
Back and exit out of the procedure
without saving and begin again. If you
click Enter and save your entries, you
will get empty customizing entries.

5. Enter a print operation (1 for New
purchase order and 2 for Changed
purchase order).

6. Enter the purchasing document
type, (NB for Standard purchase
order).

7. Enter the item category (nothing for the standard purchase order or 2 in consignment, etc.).

8. Enter for example EKPO  (Purchasing document item texts) in the text object field or TEXT for a standard
text.

9. Enter for example F03 (Material PO text) in the text id field or ST for a standard text.

10. To print standard texts compared to all the other texts, enter the standard text name in Text key.

11. After Sequence, enter the number that determines the sequence in which the text is printed. The Printing
priority field can remain empty.
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Sequence and Printing priority determine the sequence in which the texts should be
printed. It is a two-level sequence. That is, if the input after Sequence is equal for two
texts, the input after Printing priority determines the sequence.

However, Sequence can take up to 99 numbers, which is sufficient to determine a
unique sequence of text. Therefore, we recommend that you leave Printing priority
empty.

You must enter an increasing sequence in Sequence and Printing priority, but you may
skip numbers. For example, both “1, 2, 3, 4, and 5” and “3, 5, 6, and 9” are valid
sequences.

12. Select Print title to print the text title at the top of the text. Otherwise the text is printed without a title.

13. Click Save. If you use the CTS, specify a transport request after saving.

14. Click Back.

15. Repeat steps 4 through 14 for every new text that you want on the output.

If you do not want certain texts to be output, delete them:

16. Mark the box at the beginning of
those lines that you want to delete.

17. Click Delete.

To double check the print sequence, perform the following steps for all texts.

16
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18. Double click the texts you want on
the output.

19. To print standard texts compared to
all the other texts, enter the
standard text name in Text key.

20. In Sequence, enter the number that
determines the sequence in which
the text is printed. Printing priority
can remain empty.

20
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Sequence and Printing priority determine the sequence in which the texts should be printed. It
is a two-level sequence. That is, if the Sequence input is equal for two texts, then the Printing
priority input determines the sequence. However, Sequence can take up to 99 numbers, which
is sufficient to determine unique text. Therefore, we recommend that Printing priority be left
empty.

You must enter an increasing sequence in Sequence and Printing priority, but within the
sequence, you may skip numbers. For example, both “1, 2, 3, 4, and 5” and “3, 5, 6, and 9” are
valid sequences.

21. Select Print title to print the text title on top of the text. Otherwise, the text is printed without a title.

22. Click Save. If you use the CTS, specify a transport request after saving.

23. Click Back to return to the text overview screen, which will be printed.

24. Repeat steps 18 through 23 for every text that will appear on the output.

25. When you have finished, click Back.

Supplement texts

1. Click Texts for document supplement.

1
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2. On the Change View “Messages:
Supplement Texts”: Overview screen,
notice the texts that you defined to
appear at the end of all purchase
order items.

3. The most important lines are those
with document type NB (Standard
PO). Key operations are “1”(New
purchase order) and “2” (Changed
purchase order). Texts printed as
supplements can come from either
the purchase order header or
standard texts. If they come from
the purchase order header, then
EKKO is the object and id is the
header text id. If they are standard
texts, then TEXT is the object and
ST is the id.

4. Click New entries.

Enter information in the fields without
clicking Enter. After you have finished,
click Save, without hitting Enter.

If you accidentally click Enter, click
Back and completely exit out of the
procedure, without saving, and begin
again. If you click Enter and save your
entries, you will get empty
customizing entries.

5. Enter the print operation (1 for New
purchase order and 2 for Changed
purchase order).

6. Enter NB (the purchasing document
type) in Standard purchase order.

7. Enter EKKO (Purchasing document header texts) in the text object field or TEXT for a standard text.

8. Enter for example F02 (Header note) in the text id field or ST for a standard text.

9. In Print sequence, enter the number that determines the sequence in which the text is printed.
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You must enter an increasing sequence, but, within the sequence, you may
skip numbers. The following are sample, valid sequences:

• “1, 2, 3, 4, and 5”
• “3, 5, 6, and 9”
• “1, 3, 4, 6, and 8”

10. To print standard texts compared to texts from the purchase order header, enter the standard text name
in Text key.

11. Select Print title to print the text title on top of the text. Otherwise the text is printed without a title.

12. Click Save. If you use the CTS, specify a transport request after saving.

13. Click Back.

14. Repeat steps 4 through 13 for every new text that you want on the output.

If you do not want some texts to be
output, delete them:

15. Select the boxes at the beginning of
the lines you want to delete.

16. Click Delete.

15
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To double check the print sequence, perform the following steps for all texts:

17. Double click the texts you want on
the output.

18. In Print sequence, enter the number
that determines the sequence in
which the text is printed on the
output.

You must enter an increasing sequence
but, within the sequence, you may skip
numbers. Here are some sample, valid
sequences:

• “1, 2, 3, 4, and 5”
• “3, 5, 6, and 9”
• “1, 3, 4, 6, and 8”

19. To print standard texts compared
to texts from the purchase order
header, enter the standard text
name in Text key.

20. Select Print title to print the title on

20
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top of the text. Otherwise the text is
printed without a title.

21. Click Save. If you use the CTS, specify a transport request after saving.

22. Click Back to return to the text overview screen.

23. Repeat steps 17 through 22 for every text that should appear on the output.

24. When you have finished, click Back.

Change texts

1. Click Change texts.

2. On the Change View “Messages:
Change Texts” Overview screen,
notice the reasons why a purchase
order change makes it necessary to
re-print the purchase order. If
applicable, these texts appear on
the output.

3. If you want them different,
overwrite the texts.

4. Click Save.

If you use the CTS, specify a
transport request after saving.

5. Click Back.

1

2

3

4 5



Printout-Related Customizing of the Applications
Customizing in MM

© 1998 SAP Labs, Inc. 7–35

Headings

1. Click Headings.

2. The title in the shaded area of the
output, the field headings for the
purchase order number, and
purchase order date can be
changed. On the sample printouts
for the purchase order, these fields
are in the framed area (see the
appendix).

3. The most important lines are those
with document type NB (Standard
PO). Key operations are “1” (New
purchase order) and “2” (Changed
purchase order).

4. Double click the line where you
want to change the headings.
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5. Overwrite the title and the heading
for the document number and date.

If you overwrite the heading for the
document number and date, be aware
that the layout set J_9H_MEDRUCK
has the variables for the document
number and the document date under
this header. If you change this header,
the layout set may need to be changed.

6. Click Save.

If you use the CTS, specify a
transport request after saving.

7. Click Back to return to the screen from step 2.

8. Repeat steps 4 through 7 for every applicable line.

9. When you have finished, click Back twice.

10. Click Cancel.

11. Click Back twice to completely exit.

5
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Standard texts

To define the above-mentioned standard texts:

1. Choose Tools → Word processing →
Standard text.

2. Enter the text name that you
specified in the customizing steps
above.

3. Click Create/change.

4. After editing, click Save.
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Customizing in PP

Assigning Print Programs and Layout Sets to Documents
If you copied a layout set to modify it, inform the system that you want to use this new layout set for
printing. To access the relevant customizing screens:

1. Access the IMG (see page 2).

2. Expand Production.

3. Expand Production Orders.

4. Expand Operations.

5. Execute Define print control.

Under Names of Lists you see the four-
character abbreviation of the different
PP document types. These are:

• LG01 for Object list

• LG02 for Operations control
ticket

• LG03 for Goods receipt list

• LG04 for Kanban card

• LK01 for Pick list

• LK02 for Goods issue slip

• LV01 for Time ticket

• LV02 for Confirmation slip

6. Click on the icon before Layout sets.
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Layout sets are distinguished by order
type, plant, document type, and output
destination. All four columns may be
masked with XXXX.

The other columns indicate how many
sections are allowed on a page of
output, if bar code should be printed,
if a new spool file has to be created for
every new list, and if the list can be
displayed before being printed.

7. Specify the layout set name that
you want to use. You can also
create new lines to replace some of
the masks with values.

8. When you are ready, click Page
down.

9. Click on the icon before Print
reports.

7

9

8



Printout-Related Customizing of the Applications
Customizing in PP

7–40 © 1998 SAP Labs, Inc.

10. For each document type, specify
the print program name. Note that
the order type is masked.

11. When you are ready, click Save.

If you use the CTS, specify a
transport request after saving.

12. Click Back twice to return to the
IMG.

13. Click Back twice to completely exit.

Layout Set Text Elements and Document Types
Although standard PP uses only two layout sets, PSFC_STD_LAYOUT and PSFC_KANBAN,
PSFC_STD_LAYOUT is used for seven different document types by seven print programs. It is, therefore,
difficult to find out which text elements are used for which document type, and changing the content of
one text element for one particular document type affects the output of other document types.

The following table illustrates which text elements of PSFC_STD_LAYOUT are used for which document
type:

Document type Name of text element Remarks Condition

Goods issue slip
(Page MAIN is used)

HDR_RES Header

BARCODE_RSNUM_RSPOS If bar code checked in
Customizing

CMP_DATA_HDR Header for
components

CMP_DATA Components

CMP_INST

CMP_VAR_SIZED If item variable-sized

LINE_EMPTY

10
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Pick list (Page
PAG_RES is used)

NET_ROOT If collective order

NET_DATA If collective order

BARCODE_AUFNR_MATNR If bar code checked in
Customizing

BARCODE_RSNUM If bar code checked in
Customizing

ORD_TEXT Order header
text

If header text available at order

ORD_TEXT_SHORT If header text not available at
order and short text available

CMP_DATA_HDR Header for
components

If bar code not checked in
Customizing

BARCODE_RSNUM If bar code checked in
Customizing

CMP_DATA_BC_HDR Header for
components

If bar code checked in
Customizing

CMP_DATA Components If bar code not checked in
Customizing

CMP_DATA_BC Components If bar code checked in
Customizing

CMP_TEXT Component
text

If component long text available

CMP_TEXT_SHORT Component
text

If component long text not
available and short text available

Confirmation slip
(Page MAIN is used)

HDR_STD Header

OPR_DATA_HDR Operations
header

OPR_DATA Operations If bar code not checked in
Customizing

OPR_DATA_BC Operations If bar code checked in
Customizing

OPR_TEXT_SHORT Operations
text

OPR_ACT_TYP Activities If activities available

OPR_MASK Operations
mask for
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manual entry

Time ticket (Page
MAIN is used)

HDR_STD Header

OPR_SPLT_HDR Operations
split header

OPR_SPLT Operations
split

If bar code not checked in
Customizing

OPR_SPLT_BC Operations
split

If bar code checked in
Customizing

OPR_TEXT_SHORT Operations
text

OPR_ACT_TYP Activities If activities available

OPR_TYP_MACH If machine-split

OPR_TYP_PERS If person-split

OPR_MASK Operations
mask for
manual entry

HDR_STD Header

OPR_DATA_HDR Operations
header

OPR_DATA Operations If bar code not checked in
Customizing

OPR_DATA_BC Operations If bar code checked in
Customizing

OPR_TEXT_SHORT Operations
text

OPR_ACT_TYP Activities If activities available

OPR_MASK Operations
mask for
manual entry

Goods receipt list
(Page PAG_STD is
used)

NET_ROOT If collective order

NET_DATA If collective order

BARCODE_AUFNR_MATNR If bar code checked in
Customizing

ORD_TEXT Order header
text

If header text available at order
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ORD_TEXT_SHORT If header text not available at
order and short text available

CMP_GRL_HDR

CMP_GRL_HDR2

CMP_GRL_HDR3

CMP_GRL_RESBD

CMP_GRL_AFPOD

Operations control
ticket (Page
PAG_STD is used)

NET_ROOT If collective order

NET_DATA If collective order

BARCODE_AUFNR_MATNR If bar code checked in
Customizing

ORD_TEXT Order header
text

If header text available at order

ORD_TEXT_SHORT If header text not available at
order and short text available

CONFIG_DATA_HDR Configuration
header

If configurable material

CONFIG_DATA Configuration If configurable material

LINE_DOUBLE

PROD_NOTE Production
note

If production note available

ROU_TEXT Routing text If routing text available

ROU_TEXT_SHORT Routing text If routing text not available and
short text available

PAGE_NEW

SEQ_HDR_1 Sequence
header

SEQ_HDR_2 Sequence
header

LINE

OPR_DATA_HDR Operations
header

OPR_DATA Operations If bar code not checked in
Customizing
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OPR_DATA_BC Operations If bar code checked in
Customizing

OPR_TEXT_SHORT Operations
text

OPR_ACT_TYP Activities If activities available

LINE_DOTTED

PRT_OPR_HDR

PRT_DATA_HDR

PRT_DATA

PRT_TEXT If long text available

PRT_TEXT_SHORT If long text not available and
short text available

LINE

Object list (Page
PAG_RES is used)

NET_ROOT If collective order

NET_DATA If collective order

BARCODE_AUFNR_MATNR If bar code checked in
Customizing

BARCODE_RSNUM If bar code checked in
Customizing

ORD_TEXT Order header
text

If header text available at order

ORD_TEXT_SHORT If header text not available at
order and short text available

CONFIG_DATA_HDR Configuration
header

If configurable material

CONFIG_DATA Configuration If configurable material

LINE_DOUBLE

PROD_NOTE Production
note

If production note available

ROU_TEXT Routing text If routing text available

ROU_TEXT_SHORT Routing text If routing text not available and
short text available

PAGE_NEW

SEQ_HDR_1 Sequence
header



Printout-Related Customizing of the Applications
Customizing in PP

© 1998 SAP Labs, Inc. 7–45

SEQ_HDR_2 Sequence
header

LINE

OPR_DATA_HDR Operations
header

OPR_DATA Operations If bar code not checked in
Customizing

OPR_DATA_BC Operations If bar code checked in
Customizing

OPR_ACT_TYP Activities If activities available

LINE_DOTTED

CMP_OPR_HDR Operations
component
header

CMP_DATA_HDR Header for
components

If bar code not checked in
Customizing

CMP_DATA_BC_HDR Header for
components

If bar code checked in
Customizing

CMP_DATA Components If bar code not checked in
Customizing

CMP_DATA_BC Components If bar code checked in
Customizing

CMP_TEXT Component
text

If component long text available

CMP_TEXT_SHORT Component
text

If component long text not
available and short text available

LINE_DOTTED

PRT_OPR_HDR

PRT_DATA_HDR

PRT_DATA

PRT_TEXT If long text available

PRT_TEXT_SHORT LINE If long text not available and
short text available
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Customizing in FI

Assigning Print Program and Layout Set to Checks
If you have copied a layout set to modify it, inform the system that you want to use this new layout set for
printing. The following procedure shows how to access the relevant customizing screens. In addition, you
have to specify a second print program to collect data and printing. However, the print program does not
have to be changed.

1. Access the IMG (page 2).

2. Expand Financial Accounting.

3. Expand Accounts Receivable and
Accounts Payable.

4. Expand Business Transactions.

5. Expand Outgoing Payments.

6. Expand Automatic Outgoing
Payments.

7. Expand Payment Method/Bank
Selection.

8. Execute Configure payment program.
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9. Click Ctry payment methods.

10. Double click the appropriate
country.

9
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11. Double-click on the appropriate
payment method.

12. If you copied and changed the
print program, enter the new print
program in Name of the print
program in the Form printout frame.

13. Click Save.
If you use the CTS, specify a
transport request after saving.

14. Click Back three times to return to
the initial payment program
customizing screen in step 9.

11
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Entering Another Layout Set

To enter another layout set from the initial Payment Program Configuration screen:

1. Click CC Payment methods.

2. The Maintain Payment Program
Configuration: Company Codes screen
displays the company codes.

3. Double click each company code.

1
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4. Double-click on the payment
method.

5. Click Form data.

4
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6. If you copied and changed the
layout set, enter the new layout set
name in Form for the payment
transfer medium in the frame Forms.

7. Click Save. If you use the CTS,
specify a transport request after
saving.

8. Click Back three times to return to
the initial payment program
customizing screen in step 9.

9. Either click Back three times to completely exit or continue with step 9 of the next section.

Specifying Standard Texts for Header, Footer, Signature and Sender
You can specify standard texts to appear on output. The layout set for the check is only prepared to print
standard texts such as letter header, but the commands to print standard texts for footer, signature, and sender
can be easily added. Please see the end of this chapter for the commands.

The header is printed at the top of the check, and checks can use different standard texts per company
code. Not specifying a standard text is specified or if the specified standard texts do not exist, does not lead
to an error.

6
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1. Access the IMG (see page 2).

2. Expand Financial Accounting.

3. Expand Accounts Receivable and
Accounts Payable.

4. Expand Business Transactions.

5. Expand Outgoing Payments.

6. Expand Automatic Outgoing
Payments.

7. Expand Payment Method/Bank
Selection.

8. Execute Configure payment program.

9. Click Paying company codes.
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10. Double click Company code.

11. Click Sender.

10
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12. Enter the names of the standard
texts on the Payment Program
Configuration: Sender Details screen.

13. Click Save.

If you use the CTS, specify a
transport request after saving.

14. Click Back three times to return to
the initial payment program
customizing screen in step 9.

15. Either click Back three times to
completely exit or continue with
step 9 in the next section.

To define the above-mentioned standard texts:

1. Choose Tools → Word processing →
Standard text.

1
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2. Enter the text name that you
specified in the customizing steps
above.

3. Enter ADRS.

The text id is less important. Since
ADRS is used in the layout sets, it is
also the easiest to use. If you use
another text id, the corresponding
command line in the text editor of the
layout sets would have to be changed.

4. Click Create/change.

5. After editing, click Save.

If you want the standard texts for the footer, signature, and sender printed, use the following commands in
the text editor of the page window:

• Footer:
/: INCLUDE &REGUD-TXTFU& OBJECT TEXT ID ADRS

• Signature:
/: INCLUDE &REGUD-TXTUN& OBJECT TEXT ID ADRS

• Sender:
/: INCLUDE &REGUD-TXTAB& OBJECT TEXT ID ADRS

Specifying the Number of Test Prints before a Check Run
At the beginning of every check run, to adjust your printer, specify the number of test prints. This
specification is done in the variant of the print program where you can print the checks and the summary
of the check run on different printers. This topic is described in the next section, but step 15 from the next
section can be incorporated into step 15 of this section to perform both procedures at once.
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1. Access the IMG (see page 2).

2. Expand Financial Accounting.

3. Expand Accounts Receivable and
Accounts Payable.

4. Expand Business Transactions.

5. Expand Outgoing Payments.

6. Expand Automatic Outgoing
Payments.

7. Expand Payment Method/Bank
Selection.

8. Execute Configure payment program.

9. Click Ctry payment methods.
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10. Double click the appropriate
country.

11. Double click the appropriate
payment method.

10
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12. Choose Environment → Print prog.
variants.

13. Enter the name of your variant (Z1)
in Variant.

14. Click Change.

12
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Here you see the bottom of the
Maintain Variants: Report
RFFOUS_C, Variant Z1 screen.

15. Enter the number of desired test
prints in the Number of sample
printouts in the Output control
frame.

16. Click Save.

If you use the CTS, specify a
transport request after saving.

17. Click Back five times.

18. You will now be back on the initial
screen of the payment program
customizing from step 9.

19. Click Back three times to
completely exit.
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Specifying Printers for Both Checks and Check Run Summary
You can specify different printers for the checks and the check run summary. This specification makes
sense if you have preprinted checks and do not want to waste these forms for a summary, or if you want
the summary to be printed from a laser printer instead of a dot-matrix printer.

Specify printers in the variant of the print program (e.g., program RFFOUS_C, variant Z1). At the
beginning of every check run, to adjust your printer, specify the number of test prints. This topic is
described in the previous section, but you can include step 15 from the previous section into step 15 of this
section and perform both procedures at once.

1. Access the IMG (see page 2).

2. Expand Financial Accounting.

3. Expand Accounts Receivable and
Accounts Payable.

4. Expand Business Transactions.

5. Expand Outgoing Payments.

6. Expand Automatic Outgoing
Payments.

7. Expand Payment Method/Bank
Selection.

8. Execute Configure payment program.
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9. Click Ctry payment methods.

10. Double click the appropriate
country.

9
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11. Double click the appropriate
payment method.

12. Choose Environment → Print prog.
Variants.
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13. Enter the name of your variant (Z1).

14. Click Change.

Here you can see the bottom of the
Maintain Variants: Report
RFFOUS_C, Variant Z1 screen.

15. Select Print checks and Print payment
summary to get the checks and the
summary. Enter different printer
names in the corresponding On
printer fields.

16. Click Save.

If you use the CTS, specify a
transport request after saving.

17. Click Back five times to return to
the initial payment program
customizing screen in step 9.
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18. Click Back three times to
completely exit.

18
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The functionality of the SAPscript editor is determined by a number of commands, which you can either
choose from the menu or call with function keys. These commands edit the text in the editor based on your
requirements, and commands are immediately executed.

In contrast, SAPscript recognizes another type of commands, the control commands, which:

• Correspondingly influence the output formatting

• Are not interpreted by the SAPscript editor

• Only affect the SAPscript Composer

The Composer is a program that converts text from the editor display into the print display. This program
formats the line and pages where symbols are replaced by their current values and text formatting is based
on the paragraph and the character style formats.

Overview of SAPscript Control Commands

ADDRESS Formatting of addresses

BOTTOM, ENDBOTTOM Define footer text in a window

BOX, POSITION, SIZE Boxes, lines and shading

CASE, ENDCASE Case distinction

DEFINE Value assignment to text symbols

HEX, ENDHEX Hexadecimal values

IF, ENDIF Conditional text output

INCLUDE Include other texts

NEW-PAGE Explicit forms feed

NEW-WINDOW Next window MAIN

PRINT-CONTROL Insert print control character

PROTECT, ENDPROTECT Protect from page break

RESET Initialize outline paragraphs

SET COUNTRY Country-specific formatting

SET DATE MASK Formatting of date fields

SET SIGN Position of +/- sign

SET TIME MASK Formatting of time fields

STYLE Change style

SUMMING Summing variables

TOP Set header text in window MAIN
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Overview of Formatting Options

Formatting options format variables and override the format described in the Dictionary. Formatting
options are always specified within &-& variable brackets.

Exponent for floating point numbers Specifying an exponent for floating point values

Fill characters Replacing leading spaces with fill characters

Ignoring conversion rules Ignoring conversion rules from Dictionary

Leading sign to the left Leading sign of numeric values is on the left

Leading sign to the right Leading sign of numeric values is on the right

Number of decimals Specifying the number of decimal places

Offset Specifying an offset of n characters

Omitting leading zeros Omitting the leading zeros

Omitting the leading sign Omitting the leading sign of numeric values

Omitting the separator for
‘Thousands’

Omitting the separator for “Thousands” in numeric
values

Output length Specifying the output length

Preceding and subsequent text Specifying preceding and subsequent text for variables

Right-justified output Right-justified output within a specified output length

Space compression Reducing spaces between words of one variable

Suppressing initial values Suppressing output of initial values

Syntax of Control Commands

SAPscript control commands are entered, changed, or deleted in the SAPscript editor in the same way as
other text lines. However, they differ from normal lines in the following ways:

• In the tag column, indicate control commands with the paragraph format /:

• Enter the command in the line.
All key words and specifications, not defined in quotes as literal, are automatically converted to upper
case.

• Enter the complete control command and the necessary parameters on one line.

• Enter only one control command per line.

• Editor formatting does not affect lines with control commands.

If the control command is unknown or syntactically incorrect, the command line is treated as a comment
line, and is not interpreted or printed.
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If a parameter of a control command is written in parentheses, [], on the
following pages, then this parameter is optional for the command.

Some of the control commands are global settings, which are valid until they
are explicitly switched off. Therefore it is important to know that, on a page,
the MAIN window is always processed first. For example, if you want to set
the date format with the control command SET DATE FORMAT and this
format must be valid for the entire layout set, then specify this command at
the top of MAIN.

ADDRESS: Formatting of addresses
The command ADDRESS - ENDADDRESS formats an address according to the postal standards of the
destination country defined in the parameter COUNTRY. The reference fields are described in the
structure ADRS. Both constants and symbols can be assigned to the parameters.

Syntax:
/: ADDRESS [DELIVERY] [PARAGRAPH a] [PRIORITY p] [LINES l]
/: TITLE title
/: NAME name1[,name2[,name3[,name4]]]
/: STREET street
/: POBOX PO box [CODE zip code]
/: POSTCODE zip code
/: CITY town1[,town2]
/: REGION region
/: COUNTRY country
/: FROMCOUNTRY from country
/: ENDADDRESS

Both formatting data and address data are parameters. Address data is formatted for output based on the
COUNTRY, PRIORITY and LINES parameters. As the default, the P.O. Box is used, if it is available, rather
than the street address.

• DELIVERY defines the street address.
If this parameter is selected, the system prints the street address on the layout output instead of the
P.O. Box.

• PARAGRAPH defines in which paragraph format the address is output.
If the parameter is not defined, the address is output in the default paragraph format.

• PRIORITY defines which address lines can be omitted if there is not enough space on the output.
You can enter a combination of the following values:

− A form of address
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− P mandatory blank line 1

− Q mandatory blank line 2

− 2 name2

− 3 name3

− 4 name4

− L country name

− S line for the street

− O line for the city

• LINES define how many lines are available to format the address.
If the address data cannot be completely formatted due to an insufficient number of lines, the data
entered in the parameter PRIORITY is omitted. If the LINES specification is missing and this command
is in a layout set window whose type is not MAIN, the lines available for the address layout are
automatically calculated with the current output line item and window size.

• TITLE is a required form of address.

• NAME means that up to four separate names, separated by commas, can be defined.

• STREET means the street specification, including address number.

• POBOX is the Post Office box number.

• CODE is the P.O. box, postal, or zip code, if this code is different from the postal code of the city.

• POSTCODE is city’s postal, or zip, code.

• CITY means that up to two place names can be defined.

• REGION determines the administrative area.

• COUNTRY specifies the country based on specific postal standards and the address format.

• FROMCOUNTRY defines in which language the destination country’s name is formatted. In EEC
countries, only the international country identification letter is placed, with a hyphen, before the postal
code.

Example:
/: ADDRESS

/: TITLE ‘Company’

/: NAME ‘Widget Technology, Inc.’, ‘All Kind of Widgets’

/: STREET ‘1005 Lido Lane’

/: POBOX ‘2935’ CODE ‘94400’

/: POSTCODE ‘94404’

/: CITY ‘Foster City’

/: REGION ‘CA’

/: COUNTRY ‘USA’

/: FROMCOUNTRY ‘USA’

/: ENDADDRESS

This list generates the following address:
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Company
Widget Technology, Inc.
All Kind of Widgets
PO box 2935
Foster City, CA 94400

If the DELIVERY supplement is specified for the ADDRESS command, then the street, not the P.O. Box, is
entered.

Company
Widget Technology, Inc.
All Kind of Widgets
1005 Lido Lane
Foster City, CA 94404

SAPscript calls the ADDRESS_INTO_PRINTFORM function module to
format the address. If the display is not in the required form, check the
settings that are valid for this function module (see the documentation on
the function module).

BOTTOM: Define footer text in a window
For MAIN, determine the lines, also known as footer texts, which are always automatically output at the
bottom of that window.

Syntax:

/: BOTTOM

      :

      :

/: ENDBOTTOM

The text lines between the two commands are output at the bottom of MAIN.

To switch a footer text off, enter the command pair BOTTOM .. ENDBOTTOM with no text lines in
between:

/: BOTTOM

/: ENDBOTTOM

Footer text no longer appears at the bottom of the page from and including this page.

If there is sufficient space in the window, a footer text is output on the
current page.

Only use footer texts in texts that are not printed with application programs,
such as dunning texts, ordering texts. These application programs also work
with footer texts with the layout set interface, which can lead to unwanted
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results.

BOX, POSITION, SIZE: Boxes, lines, shading
The BOX, POSITION and SIZE commands draw boxes, lines, and shadows. Within any particular layout
set, these commands specify window or passage of window text can be output in a frame or with
shadowing. The SAP printer drivers based on page-oriented printers (the HP LaserJet PCL-5 driver HPLJ4,
the Postscript driver POST, the Kyocera Prescribe driver PRES) use these commands when creating output.
Line printers and non-supported page-oriented printers ignore these commands. The resulting output may
be viewed in the SAPscript print previewer.

Syntax:

1. /: BOX [XPOS] [YPOS] [WIDTH] [HEIGHT] [FRAME] [INTENSITY]

2. /: POSITION [XORIGIN] [YORIGIN] [WINDOW] [PAGE]

3. /: SIZE [WIDTH] [HEIGHT] [WINDOW] [PAGE]

BOX

Syntax:

/: BOX [XPOS] [YPOS] [WIDTH] [HEIGHT] [FRAME] [INTENSITY]

This command draws a box of the specified size at the specified position. For each parameter (XPOS,
YPOS, WIDTH, HEIGHT, and FRAME), both a measurement and a unit of measure must be specified. The
INTENSITY parameter should be entered as a percentage between 0 and 100.

• XPOS, YPOS specify the upper left corner of the box, relative to POSITION command values.
Default is the values specified in the POSITION command.
The following calculation is performed internally to determine the absolute output position of a box on
the page:
X(abs) = XORIGIN + XPOS
Y(abs) = YORIGIN + YPOS

• WIDTH determines the width of the box.
Default: WIDTH value of the SIZE command.

• HEIGHT determines height of the box.
Default: HEIGHT value of the SIZE command.

• FRAME determines the thickness of frame.
Default: 0 (no frame).

• INTENSITY determines the box contents as a grayscale percentage.
Default: 100 (full black)

When determining the measurements, use decimal numbers to specify literal values (like ABAP/4 numeric
constants) and enclose these values in inverted commas. Use a period for the decimal point character. See
also the examples listed below.

Use the following units of measure:

• TW (twip)
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• PT (point)

• IN (inch)

• MM (millimeter)

• CM (centimeter)

• LN (line)

• CH (character).

The following conversion factors apply:

• 1 TW = 1/20 PT

• 1 PT = 1/72 IN

• 1 IN = 2.54 CM

• 1 CM = 10 MM

• 1 CH = height of a character relative to the CPI specification in the layout set header

• 1 LN = height of a line relative to the LPI specification in the layout set header

Examples:

/: BOX FRAME 10 TW

Draws a frame around the current window with a frame thickness of 10 TW (= 0.5 PT).

/: BOX INTENSITY 10

Fills the window background with shadowing having a gray scale of 10 %.

/: BOX HEIGHT 0 TW FRAME 10 TW

Draws a horizontal line across the complete top edge of the window.

/: BOX WIDTH 0 TW FRAME 10 TW

Draws a vertical line along the complete height of the left hand edge of the window.

/: BOX WIDTH ’17.5’ CM HEIGHT 1 CM FRAME 10 TW INTENSITY 15

/: BOX WIDTH ’17.5’ CM HEIGHT ’13.5’ CM FRAME 10 TW

/: BOX XPOS ’10.0’ CM WIDTH 0 TW HEIGHT ’13.5’ CM FRAME 10 TW

/: BOX XPOS ’13.5’ CM WIDTH 0 TW HEIGHT ’13.5’ CM FRAME 10 TW

Draws two rectangles and two lines to construct a table of three columns with a highlighted heading.
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POSITION

Syntax:

/: POSITION [XORIGIN] [YORIGIN] [WINDOW] [PAGE]

This command sets the origin for the coordinate system used by the XPOS and YPOS parameters of the
BOX command. When a window is first started, the POSITION value is set to refer to the upper left corner
of the window (default setting). If a parameter value does not have a leading sign, then its value is
interpreted as an absolute value, which is a value that specifies an offset from the upper-left corner of the
output page. If a parameter value is specified with a leading sign, then the new value of the parameter is
calculated relative to the old value. If a parameter specification is missing, then this parameter is
unchanged.

• XORIGIN, YORIGIN is the origin of the coordinate system.

• WINDOW sets the values for the left and upper edges to be the same of those of the current window
(default setting).

• PAGE sets the values for the left and upper edges to be the same as the current output page (XORIGIN
= 0 cm, YORIGIN = 0 cm).

Examples:

/: POSITION WINDOW

Sets the origin for the coordinate system to the upper-left corner of the window.

/: POSITION XORIGIN 2 CM YORIGIN ’2.5 CM’

Sets the origin for the coordinate system to a point 2 cm from the left edge and 2.5 cm from the upper edge
of the output page.

/: POSITION XORIGIN ’-1.5’ CM YORIGIN -1 CM

Shifts the origin for the coordinates 1.5 cm to the left and 1 cm up.

SIZE

Syntax:

/: SIZE [WIDTH] [HEIGHT] [WINDOW] [PAGE]

This command sets the values of the WIDTH and HEIGHT parameters used in the BOX command. When a
window is first started, the SIZE value is set to the same values as the window (default setting). If one of
the parameter specifications is missing, then no change is made to its current value. If a parameter value
does not have a leading sign, then its value is interpreted as an absolute value. If a parameter value is
specified with a leading sign, then the new value of the parameter is calculated relative to the old value.

• WIDTH, HEIGHT sets the dimensions of the rectangle or line.

• WINDOW sets the values for the width and height relative to the values of the current window (default
setting).

• PAGE sets the values for the width and height to the values of the current output page.
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Examples:

/: SIZE WINDOW

Sets WIDTH and HEIGHT to the current window dimensions.

/: SIZE WIDTH ’3.5’ CM HEIGHT ’7.6’ CM

Sets WIDTH to 3.5 cm and HEIGHT to 7.6 cm.

/: POSITION WINDOW

/: POSITION XORIGIN -20 TW YORIGIN -20 TW

/: SIZE WIDTH +40 TW HEIGHT +40 TW

/: BOX FRAME 10 TW

A frame is added to the current window. The frame edges extends beyond the window itself, to avoid
obscuring the leading and trailing text characters.

CASE: Case distinction
The CASE command is a special case of multi-level case distinction with IF commands. As a condition for
the different cases, only one symbol can be queried for equality with different values.

Syntax:

/: CASE symbol

/: WHEN value1

      :

/: WHEN value2

      :

/: WHEN value n

      :

/: WHEN OTHERS.

      :

/: ENDCASE

The symbol entered in the CASE line is formatted. If it has a value specified in the individual WHEN lines,
the text following the valid WHEN line is output. If none of the listed values apply, the lines between the
WHEN-OTHERS line and ENDCASE are output. The WHEN-OTHERS case is optional. Comparison is
always carried out as a literal comparison as for the IF command.

ENDCASE must end a CASE command, but the WHEN-OTHERS command
is optional.
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DEFINE: Value assignment to text symbols
Text symbols receive their value through an explicit assignment. This assignment can be made
interactively in the editor by choosing Include → Symbols → Text. This step lists all the text symbols of a text
module and those of the allocated layout set. If the transaction is exited, the contents defined in this way
are lost. To continue printing the text module, you would have to enter the symbol values again.

The DEFINE command allows you to anchor this value assignment in the text and to have it available
when you next call up the text. Furthermore, you can allocate another value to a text symbol in the course
of the text.

Syntax:

/: DEFINE &symbolname& = ‘ value’

Example:

/: DEFINE &re& = ‘Your correspondence of 3/17/94’

Example:

/: DEFINE &symbol1& = ‘xxxxxxx’

/: DEFINE &symbol2& = ‘yyy&symbol1&’

/: DEFINE &symbol1& = ‘zzzzzzz’

Result: &symbol2& → yyyzzzzzzz

The assigned value may have a maximum of 60 characters, but it can also contain more symbols. When a
symbol is defined using DEFINE, symbols which occur in the value are not immediately replaced by their
value. They are replaced only when the target symbol is output. If operator := is used in DEFINE, the
symbols that occur in the value to be assigned are immediately replaced by their current values. The
resulting character string is only then assigned to the target symbol when all occurring symbols have been
replaced. The length of the value is limited to 80 characters, and the target symbol must be a text symbol.

Syntax:

/: DEFINE & symbolname& := ‘ value’

HEX: Hexadecimal Data
This command sends printer commands in a printer language directly to a printer that supports that
language. SAPscript does not interpret the data enclosed by the HEX and ENDHEX command pair, but
inserts unchanged data into the output stream. This technique allows objects with a pixel-oriented format
to be printed as part of a SAPscript text. The HEX and ENDHEX command pair enclose the printer
commands and data as hexadecimal text, so that the printer formatting routines interpret each successive
pair of characters as a single hexadecimal value in the 0..255 range.

The characters 0..9 and A..F to represent the values 10..15 are valid hexadecimal characters. The text may
also include comment lines (these begin with /* in the format column), which will not be interpreted as
hexadecimal data but are simply passed over by the formatting routines.
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Syntax:

/: HEX [TYPE printer_language]

     :

     :

/: ENDHEX

HEX denotes the start of the hexadecimal data. Subsequent text lines are interpreted as described above. If
the TYPE parameter is present, the data will be sent to the printer only if the printer understands the
specified printer language. The following printer languages are currently supported:

• POST (Postscript)

• PRES (Kyocera Prescribe)

• PCL (HP Printer Control Language)

/: HEX [TYPE printer_language] [XPOS x_position] [YPOS y_position]

Before the hexadecimal data is output, the output cursor is set to the absolute position indicated by the
specified X and Y position parameters. If either the X or the Y position is not specified, then 0 will be
assumed for this parameter.

/: HEX [TYPE printer_language] [HEIGHT height] [LEFT left_indentation]

The HEIGHT parameter determines the amount of space to be reserved on the page for the output of the
hexadecimal data. Any text after ENDHEX will be output below this point. If the LEFT parameter is also
specified, then the output of the hexadecimal data will be indented from the left margin by the specified
amount.

Examples:

/: HEX TYPE PCL HEIGHT ’7.5’ CM LEFT ’2.25’ CM

/* Creator: report ZQVNTE30 date 19940705 time 125129 user SAPSCRIPT

/= 1B2A7230461B2A743735521B2A7231411B2A62304D1B2A62343057FFFFFFFFFFFF

/= FF1B2A62343057FFFFFFFFFFFFC0007D00DFC0F7D0000000000000000000000017

/: ENDHEX

This data will be printed only by an HP PCL printer (7.5 cm of space will allocated on the page for the
output of the data and the output cursor will be indented 2.25 cm to the right of the layout set window
edge).

The RSTXLDMC program uploads correctly formatted pixel data to the R/3
system and prepares it as a HEX-ENDHEX control command. This data can
then be saved as normal SAPscript text.
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IF: Conditional text output
With the IF control command, define those lines that are output under certain conditions. If the logical
expression entered for the IF command is fulfilled, the lines parenthesized by IF ... ENDIF are output. If
this expression is not enclosed in parentheses, the commands are ignored.

Syntax:

/: IF Condition

    :

    :

/: ENDIF

In the condition, the following relational operators are possible:

• = or EQ equals

• < or LT less than

• > or GT greater than

• <= or LE less than or equal to

• >= or GE greater than or equal to

• <> or NE not equal

As logical link operators use:

• NOT

• AND

• OR

The sequence of processing the logical operations and the sequence of processing the conditions is always
from left to right. There is no order of binding, and bracketing is not allowed.

Comparison is always carried out as a literal comparison, that is, symbols are compared in their formatted
form as a character string and not with their internal representation. This comparison must be taken into
account for program symbols whose format depends on different parameters. Examples include currency
fields that are output with different number of places after the decimal point depending on the currency
key, or that use a comma or a period as the decimal separator depending on the setting.

The IF command can be extended to make a two-sided case distinction with the ELSE command. If the
specified IF condition is true, then the lines listed between IF and ELSE are formatted, otherwise the lines
between ELSE and ENDIF are formatted.

Syntax:

/: IF Condition

    :

/: ELSE

    :

/: ENDIF
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A multi-level case distinction is possible using the ELSEIF command.

Syntax:

/: IF Condition

    :

/: ELSEIF Condition

    :

/: ELSE

    :

/: ENDIF

You can use as many ELSEIF commands as required. The specification of an ELSE command is optional in
this case.

• The condition must not extend over several lines, and must be contained
in one line with the IF or ELSEIF command.

• IF commands can also be nested.

• An IF command must always end with ENDIF. If this command is
forgotten, and if the condition is not true, nothing more is output after
the IF command.

• If a syntax error is found when interpreting these commands, the
corresponding command is not executed. This can have various effects
on the following text output. If, for example, the IF statement is
incorrectly structured, since IF is missing, the following ELSEIF or ELSE
commands are ignored. All lines are output.

INCLUDE: Include other texts
Use INCLUDE to include the contents of another text into your text. The text to be included exists
separately from yours and is only copied at the time of the output formatting. With INCLUDE, since the
text is only read and inserted during the output formatting, the most current version of the required text is
always available.

Syntax:

/: INCLUDE name [OBJECT o] [ID i] [LANGUAGE l] [PARAGRAPH p] [NEW-PARAGRAPH np]

The name of the text to be inserted must be specified and can have up to 70 characters. If the text name
contains blanks, put it in quotes as a literal. It can also be specified with a symbol. All further parameters of
INCLUDE are optional. If these parameters are missing, SAPscript uses default values based on the
respective call environment for them.

Examples:

/: INCLUDE MYTEXT

The text MYTEXT is included in the language of the calling text.

/: INCLUDE MYTEXT LANGUAGE ‘E’ PARAGRAPH ‘A1’
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The text with the name MYTEXT and the language E is included, regardless of the language in which the
calling text is created. The paragraph format A1 is valid as the standard paragraph for this call.

Optional specifications:

• LANGUAGE
If a language is unspecified, the calling text’s language or the layout set is set for the text to be included.
If a language is specified, the text is always loaded in this language, regardless of the language of the
calling text.

• PARAGRAPH
The text to be included is formatted with its style allocation. With this parameter, the standard
paragraph of this style can be redefined for the current call. All * paragraphs of the inserted text are
formatted with the paragraph specified here.

• NEW-PARAGRAPH
The first line of the included text has this format flag, provided it is not a command or comment line. If
the optional entry PARAGRAPH (see above) is empty, all * paragraphs of the included text are
formatted with the paragraph np specified with NEW-PARAGRAPH.

• OBJECT
To completely specify a text, create additional specifications about the text object. There are different
rules and restrictions for this specification that depends on the calling text’s object type. All texts can be
included in a layout set. If no object is entered here, TEXT is used (standard texts). With a
documentation text (object DOKU), you can only include documentation texts. This object is assumed
even if no object is specified in this environment.

Only hypertext or documentation text can be included into a hypertext (object DSYS). If the OBJECT
specification is missing, DSYS is set as a default value.
Only standard text (object TEXT), documentation text or hypertext can be included in any other type of
text. The default object is TEXT if nothing is entered.

• ID
The text ID allows further text types within an object, is a further part of the text key. If the ID is not
entered, the default Include ID from table TTXID is used to call text. If the specification is not in this
table, the text ID of the calling text is used.

The ID and the object are now the basis of a further consistency check:

• All text IDs are allowed for a layout set.

• Only documentation texts with the text IDs TX (general texts), UO (authorization objects), and
documentation texts (with the same text ID as the calling documentation text) may be included in
documentation texts.

• All DSYS texts may be included in DSYS texts, regardless of their ID. Documentation texts that will be
inserted may only have IDs TX and UO.

• Standard texts with the allowed text IDs, DSYS texts with IDs, and documentation texts with IDs TX
and UO may be included in the text types.
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NEW-PAGE: Explicit form feed
SAPscript automatically inserts a page break if MAIN of one page is filled. Using NEW-PAGE, a page
break can be forced at any point. The text after this command is written on a new page. The form feed is
independent of any conditions. The command now outputs the current page.

If you have entered NEW-PAGE without additional parameters, the page defined in the layout set as the
next page is accessed. If, however, there are various pages in your layout set, you can jump to any
particular next page by specifying the page name.

Syntax:

/: NEW-PAGE [page name]

Examples:

/: NEW-PAGE

The current page is completed and the text in the following lines is written on the next page as determined
in the layout set.

/: NEW-PAGE S1

Same as before, but S1 is accessed as the next page.

If an explicitly specified page for NEW-PAGE is not in the layout set, this
page specification is ignored. Make sure that there are no blank lines
immediately before a NEW-PAGE command. If an implicit form feed was
carried out within these blank lines, this step could lead to an unwanted
empty page being printed.

NEW-WINDOW: Next window MAIN
You can have up to 99 MAIN windows on one page. These windows are distinguished by a serial number
(0..98) and assigned in this order. So, with SAPscript, it is possible to print labels or to output text in
multiple columns. If one MAIN window is filled, then the next MAIN window on the page is automatically
accessed. A page break is inserted at the end of the final MAIN window.

Using NEW-WINDOW, even if the current window is not completely filled, you can explicitly call the next
window MAIN. If you are currently in the last MAIN window of the page, the command works as a NEW-
PAGE.

Syntax:

/: NEW-WINDOW

PRINT-CONTROL: Insert print control character
This command allows you call certain printer functions from SAPscript text. The control characters for the
printer cannot be directly entered into your text. First, with the spool transaction SPAD, define a print
control that contains the required printer commands. This print control can now be called with the
SAPscript command PRINT-CONTROL.

Syntax:



SAPscript Control Commands
Syntax of Control Commands

© 1998 SAP Labs, Inc. 8–17

/: PRINT-CONTROL name

The name of the required print control can be entered with or without quotes.

SAPscript has no idea of what is contained in the print control. It cannot
check whether the printer commands hidden behind it are functional. If
problems result when printing such a text, first print the text without the
print controls, and then activate each PRINT-CONTROL command to help
you locate the error more easily.
On completion, make sure that the defined print control sequences restore
the printer to a defined status. When printing subsequent texts, SAPscript
assumes that certain settings are still valid (type font, current page). If these
settings are changed by the called printer commands, this change can have
unwanted effects.

After performing PRINT-CONTROL, SAPscript inserts a blank at the start of the following line. If this is
not required, this line must have the paragraph format “=.”

PROTECT: Protect from page break
You can determine whether a paragraph should or should not be separated by a page break in the style or
layout set. If the attribute page protection is set, then all the lines of this paragraph are always output
together on one page. This attribute is linked to the respective paragraph.

It is not beneficial to provide all paragraphs with a page protection attribute to neutralize unwanted page
breaks. This event is too dynamic and only results from the current text. Furthermore, you may also want
to protect only parts of a paragraph from a page break.

In principle, this problem could be solved with NEW-PAGE by explicitly starting a new page before the
affected parts of the text. However, it is complicated to change this procedure. Using NEW-PAGE, if your
text is formatted to have no unwanted page breaks, and new lines are inserted and existing ones are
deleted, the NEW-PAGE commands inserted after this point will have to be checked and can result in the
movement of page breaks.

With the command pair PROTECT .. ENDPROTECT, SAPscript offers the option to individually define
protection from a page break. If you parenthesize text with these commands, SAPscript automatically
guarantees that all of its lines are printed on one page. If the lines fit on the current output page, they are
output there, as if PROTECT was not used. If, however, the space is not sufficient, PROTECT works like a
NEW-PAGE and generates a form feed.

So, you can view PROTECT/ENDPROTECT are conditional NEW-PAGE commands, that determine
whether the included lines fit into the current window MAIN or not.

Syntax:

/: PROTECT

      :

      :

/: ENDPROTECT



SAPscript Control Commands
Syntax of Control Commands

8–18 © 1998 SAP Labs, Inc.

The lines to be protected lie between the two commands.

• An ENDPROTECT command without a preceding PROTECT command
is ineffective.

• If the last ENDPROTECT is missing, it is implicitly assumed at the end
of the text.

• PROTECT .. ENDPROTECT commands cannot be nested. If a second
PROTECT command is recognized while another is active, the second is
ignored.

• If the text between PROTECT and ENDPROTECT is so extensive that it
would not fit on an empty page, then only one form feed is generated
and the text is normally output. Thus, in this case, the section to be
protected is separated by a page break.

RESET: Initialize outline paragraphs
The RESET command resets the numbering of an outline paragraph to its initial value. If the user does not
use RESET, all the outline paragraphs of a text are sequentially numbered. If the name of an outline
paragraph is entered in RESET, the numbering of this paragraph, is initialized with subordinate outline
levels.

Syntax:

/: RESET paragraph format

The paragraph format specifies the outline paragraph to be initialized.

Example:

Assume that paragraph N1 is defined in the style that you are using. This paragraph should be used for
listings and it each time generates an output of a list number. This is the SAPscript editor:

• AS If you want to work with the SAP R/3 System, proceed as follows:

• N1 Make sure that you have a PC

• N1 Switch on the PC

• N1 Click on the SAP icon.

• AS You then reach the SAP logon screen. To log on, you must carry out the following steps:

• /: RESET N1

• N1 Enter your user ID

• N1 Enter your password

• N1 Choose the application you require
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This text would give the following output:

If you want to work with the SAP R/3 System, proceed as follows:

1. Make sure that you have a PC

2. Switch on the PC

3. Click on the SAP icon.

You then reach the SAP logon screen. To log on, you must carry out the following steps:

1. Enter your user ID

2. Enter your password

3. Choose the application you require

If the RESET command between the two lines is missing, then both of the listings would be sequentially
numbered:

If you want to work with the SAP R/3 System, proceed as follows:

1. Make sure that you have a PC

2. Switch on the PC

3. Click on the SAP icon.

At the SAP logon screen, to log on:

4. Enter your user ID

5. Enter your password

6. Choose the application you require

SET COUNTRY: Country-specific formatting
Some field types are formatted to be country-specific. This includes the display of a date, the decimal point,
or the thousands separator. Normally, the display types defined in the user master record are used here.
With the control command SET COUNTRY, a format alternative to that in the user master record can be
chosen, which is stored country-specifically in table T005X.

Syntax:

/: SET COUNTRY Country key

This country key can be entered either directly in quotes or with a symbol.

Example:

/: SET COUNTRY ‘CAN’

/: SET COUNTRY & country key&

By entering an empty country name, you can return to the values set in the user master record.

/: SET COUNTRY ‘ ‘

The corresponding ABAP/4 command is called internally by SAPscript.
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If the required formats are incorrect, check the settings in table T005X.

SET DATE MASK: Formatting of date fields
Formatting date fields can be defined with the SAPscript command SET DATE MASK. After executing this
command, all the date fields are output with this display.

Syntax:

/: SET DATE MASK = ‘ date mask’

In the date mask, the following edit formats can be used:

• DD Day (two-digit)

• DDD Day name abbreviated

• DDDD Day name in full

• MM Month (two-digit)

• MMM Month name abbreviated

• MMMM Month name in full

• YY Year (two-digit)

• YYYY Year (four-digit)

All other characters in the mask are interpreted as text and copied correspondingly.

Example:

Assume that the current system date is March 1st 1994.

/: SET DATE MASK = ‘Walldorf, DD.MM.YY’

&DATE&

Result: Walldorf, 01.03.94

/: SET DATE MASK = ‘MMMM, DD. YYYY’

&DATE&

Result: March, 01. 1994

By specifying an empty string as the date mask, you can switch back to the default display:

/: SET DATE MASK = ‘ ‘

The texts for the month and day names, shortened or in full, are stored language-dependently in table
TTDTG under the following arguments:

• %%SAPSCRIPT_DDD_dd abbreviated day name

• %%SAPSCRIPT_DDDD_dd full day name

• %%SAPSCRIPT_MMM_mm abbreviated month name
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• %%SAPSCRIPT_MMMM_mm full month name
with dd: day number 01 = Monday,..., 07 = Sunday

mm: month number 01 = January,..., 12 = December

SET SIGN: The Position of +/-
For commercial applications, it is common for the “+/-“ signs to be displayed to the right of the number
value. In certain cases, however, it is necessary for these signs to be displayed to the left of the number
value. This position can be determined with the control command SET SIGN. All program symbols
formatted using this command and that have a “+/-“ sign are displayed in the required fashion.

Syntax:

/: SET SIGN LEFT

The +/- sign is displayed to the left of the number.

/: SET SIGN RIGHT

The +/- sign is displayed to the right of the number.

SET TIME MASK: Formatting of time fields
With the SAPscript command SET TIME MASK, time fields can be alternatively formatted to the standard
display.

Syntax:

/: SET TIME MASK = ‘ time mask’

The following edit formats can be used in the time mask:

• HH hours (two-digit)

• MM minutes (two-digit)

• SS seconds (two-digit)

All other characters in the mask are interpreted as text and printed correspondingly.

Example:

Assume that the current time is 10:08:12.

/: SET TIME MASK = ‘HH:MM’

&TIME&

Result: 10:08

/: SET TIME MASK = ‘HH hours MM minutes’

&TIME&

Result: 10 hours 08 minutes

By specifying an empty string as a time mask, you can switch back to the default display:

/: SET TIME MASK = ‘ ‘
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STYLE: Change style
The control command STYLE changes style within a text. This other style is used until a new STYLE
command is entered. If * is entered as a style name, switch back to the original style.

Syntax:

/: STYLE style

/: STYLE *

If another text module is inserted by choosing Include → Text and immediately deleted, STYLE is
automatically set in the editor. The same occurs if the text contents included in INCLUDE are copied into
the text by choosing Edit → Selected area → Delete INCLUDE.

SUMMING
Program symbols can be added with the SUMMING command. The command needs to be defined only
once. Each time that the specified symbol is edited, its current value is added to the sum field. Several
program symbols can also be added in a sum field.

Syntax:

/:SUMMING program symbol INTO sum symbol

Since SAPscript can not dynamically define sum fields, the sum symbol must be in a calling program
structure that was declared with TABLES.

TOP: Set header text in MAIN
In MAIN, lines that are always automatically output at the top of the window, called header texts, can be
determined. Header texts can automatically repeat the table heading at the top of every page for an
extensive tabular list.

Syntax:

/: TOP

    :

    :

/: ENDTOP

Those text lines between the two commands will be output at the top of MAIN.

To switch a header text off, re-enter the command pair TOP .. ENDTOP, with no lines in between:

/: TOP

/: ENDTOP

Header text will not appear on subsequent pages.
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• If the document window contains text, then the header text is effective
from the next page.

• The same applies to deleting a header text. That is, a header text that has
already been output can no longer be canceled on the current page.

• Only use header texts in texts that are not printed with application
programs, such as dunning texts and ordering texts. These application
programs can also work with header texts in the layout set interface,
which can lead to unwanted results.

Syntax of Formatting Options

Exponent for floating point numbers
How a floating point number is formatted depends on whether an exponent is specified. The mantissa is
adjusted by shifting the decimal point and, if necessary, introducing leading zeros, based on the chosen
exponent. An exponent value of 0 means that the exponent representation will not be used to display the
symbol.

Syntax:

&symbol(En)&

Example:

In this example the PLMK-SOLLWERT field is assumed to have the value 123456.78 and to be of data type
FLTP.

&PLMK-SOLLWERT& +1.23456780000000E+05
&PLMK-SOLLWERT(E3)& +123.456780000000E+03
&PLMK-SOLLWERT(E6)& +0.12345678000000E+06
&PLMK-SOLLWERT(E0)& +123456.780000000
&PLMK-SOLLWERT(E)& +123456.780000000

Fill characters
Leading spaces in a value can be replaced with a fill character. The character immediately following the F
in the specification is used as the fill character.

Syntax:

&symbol(Ff)&

Example:

The figure for customer sales in the KNA1-UMSAT field is $700. The Dictionary description of the field
specifies an output length of eight.
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&KNA1-UMSAT&     700.00
&KNA1-UMSAT(F*)&  **700.00
&KNA1-UMSAT(F0)& 00700.00

Ignoring conversion rules
SAPscript conversion routines specified in the Dictionary are automatically recognized and used when
program symbols are formatted. These conversions can be prevented with the K option.

Syntax:

&symbol(K)&

Leading sign to the left
The leading sign is normally displayed to the right of a numeric value, except when using a floating point
number. This option allows you to specify that the leading sign is placed to the left of the number.

Syntax:

&symbol(<)&

Example:

&ITCDP-TDULPOS&  100.00-
&ITCDP-TDULPOS(<)&  -100.00

The SET SIGN LEFT control command specifies that all subsequent symbols
with a numeric value should have a left-justified leading sign. Using this
control command means that there is then no need to repeat the < option for
each individual symbol.

Leading sign to the right
The default setting outputs the leading sign to the right of a numeric value. If you used the SET SIGN LEFT
to specify that the leading sign should be output before the value, this specification can be overridden for
individual symbols to enable these values to be output with the leading sign to the right.

Syntax:

&symbol(>)&

Use the SET SIGN RIGHT control command to switch back to the default
setting to output the leading sign.
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Number of decimals
A program symbol of one of the data types DEC, QUAN and FLTP can contain decimal place data. This
option overrides the Dictionary definition for the number of decimal places to format this symbol value.

Syntax:

&symbol(.n)&

Example:

The EKPO-MENGE field contains the value 1234.56. The Dictionary definition specifies three decimal places
and an output length of 17.

&EKPO-MENGE&         1,234.560
&EKPO-MENGE(.1)&             1,234.6
&EKPO-MENGE(.4)&       1,234.5600
&EKPO-MENGE(.0)&                1,235

Offset
Specifying an offset of “n” causes the “n” left-most characters of the symbol value will not be displayed. If
the offset specified is greater than the length of the value, nothing is output.

Syntax:

&symbol+n&

Example:

If symbol has the value 123456789, the following will be displayed:

&symbol& 123456789
&symbol+3& 456789
&symbol+7& 89
&symbol+12&

&symbol+0& 123456789

Omitting leading zeros
Certain symbol values are output with leading zeros. To suppress these values use the Z option.

Syntax:

&symbol(Z)&

Example:

Assuming the current date is 1/1/1994.

&DAY& 01
&DAY(Z)& 1
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Omitting the leading sign
Program symbols with numeric values can have a leading sign, which usually appears at the right of the
numeric value as a space for positive numbers, or as a minus sign for negative numbers. The S option
ensures that the value is formatted without the sign.

Syntax:

&symbol(S)&

Example:

The ITCDP-TDULPOS field contains the value -100.00. The ABAP/4 Dictionary definition for this field
includes a leading sign.

&ITCDP-TDULPOS& 100.00-
&ITCDP-TDULPOS(S)&  100.00

Omitting the separator for “Thousands”
Symbols of the DEC, CURR, INT and QUAN data types are normally formatted with the “thousands”
separator character. The T option allows you to specify that this separator character should be omitted.

Syntax:

&symbol(T)&

Example:

The EKPO-MENGE field contains the value 1234.56. The Data Dictionary definition specifies three decimal
places and the output length is set to 17.

&EKPO-MENGE&         1,234.560
&EKPO-MENGE(T)&          1234.560

Output length
If you need only a part of the symbol value, or if the output has to fit in an on-screen box or field without
overlapping the edges of this area, use an output length specification to define how many character
positions should be copied from the value.

If a length is specified that is greater than the current value length, then spaces are appended to the symbol
value.

The character * specifies the program symbol length. This specification causes the symbol value to be
output based on the output length defined in the ABAP/4 Dictionary.

Syntax:

&symbol(l)&

Example:

If symbol has the value 123456789.

&symbol(3)& 123
&symbol(7)& 1234567
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An output length specification can be combined with an offset specification. The specified length is then
counted from the specified offset position.

&symbol+4(3)& 567

The SYST-UNAME field contains the logon name of a user called Einstein. The Dictionary entry for this
field contains an output length of 12.

&SYST-UNAME&... Einstein...
&SYST-UNAME(9)&... Einstein ...
&SYST-UNAME(*)&... Einstein    ...

Preceding and subsequent text
In addition to using initial symbol values, additional texts that are output only when the symbol value is
no longer the initial value can be specified. You can specify a text to be output immediately before the
symbol value (the pre-text), and text to be output immediately after it (the post-text). If the symbol has its
initial value, these texts are suppressed.

Syntax:

&’pre-text’symbol’post-text’&

Ensure that the symbol, the pre-text and the post-text, all appear on a single
line of the editor. This may mean that you have to use a long line (paragraph
attribute = or /= ) in the editor.

The apostrophe character delimits these texts. If this character also appears as
part of one of these texts, then it must be written twice at this point to avoid
misinterpretation. A pre-text or post-text may contain symbols in addition to
normal text. These symbols are subject to the restriction that these symbols
may not have a pre-text or a post-text.

Example:

The KNA1-PFACH field contains a customer PO Box number. Since “PO Box” is not stored in the field
with the value, you would normally write the following for the PO Box line of an address:

PO Box &KNA1-PFACH&

However, if no “P.O. Box” has been specified then “PO Box” would still appear on its own in the address.
Prevent this step by using pre-text and/or post-text (in this case pre-text).

PO Box &KNA1-PFACH& PO Box
&’PO Box ’KNA1-PFACH&

If “P.O. Box” is specified, then this information will be displayed with the appropriate text in the usual
way.

&’PO Box ’KNA1-PFACH& PO Box 123456
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Right-justified output
Symbol values other than numeric values are normally formatted to be left-justified. Right-justified
formatting can be specified with the R option. This option has to be used with an output length
specification.

Syntax:

&symbol(R)&

Example:

If symbol has the value 1234.

&symbol& 1234
&symbol(8R)&         1234

Space compression
The symbol value is viewed as a sequence of “words,” each separated from the next by either one or a
string of space characters. The C option replaces each string of space characters with a single space and
shifting “words” to the left to close gaps. Leading spaces are completely removed. The results are the same
as if the ABAP command CONDENSE was used.

Syntax:

&symbol(C)&

Example:

Assuming '    Albert    Einstein  ' is the symbol value.

&symbol&     Albert    Einstein
&symbol(C)& Albert Einstein

Suppressing initial values
The I option suppresses the output of symbols that still contain their initial value.

Syntax:

&symbol(I)&

Example:

Assuming KNA1-UMSAT contains the value 0 and the currency is USD.

&KNA1-UMSAT&       0.00
&KNA1-UMSAT(I)&

If the field contains an amount other than 0, this value will be output in the usual way.

&KNA1-UMSAT&     700.00
&KNA1-UMSAT(I)&     700.00
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System Variables

&SAPSCRIPT-SUBRC&

After executing an INCLUDE statement, this contains a value that indicates whether the INCLUDE was
found or not. This value can be queried with IF....
INCLUDE found = 0 and INCLUDE not found = 4

&SAPSCRIPT-FORMPAGES&

This contains the total number of pages output in a SAPscript layout set (all output between the functions
START_FORM and END_FORM). The state of the page counter on the individual form pages
(START,HOLD,INC) is not taken into account.

Using this symbol impairs performance, since all output data for every
layout set must be retained internally to fill the symbol.

The CONDENSE option cannot be used on the program icon SAPSCRIPT-
FORMPAGES (C) without an explicit length specification. This symbol is
replaced with a value only after the form has been completely edited, since
the total number of pages of a form is first known in the program function
END_FORM or CLOSE_FORM.

However, the symbol size (number of characters) is reserved correctly when
the symbol first occurs, with the current page number. Therefore, only one
character is reserved for option C (CONDENSE) on pages 1-9, two characters
on pages 10-99, and so on.

&SAPSCRIPT-JOBPAGES&

This contains the total number of pages output in a SAPscript print run (all output between the functions
OPEN_FORM and CLOSE_FORM). The state of the page counter on the individual form pages
(START,HOLD,INC) is not taken into account.

Using this symbol impairs performance, since all output data for every print
job must be retained internally to fill the symbol.
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&SAPSCRIPT-TELELAND&

This contains the country identifier for the fax destination with fax output with SAPscript (field ITCPO-
TDTELELAND for the parameter OPTIONS of function OPEN_FORM).

&SAPSCRIPT-TELENUM&

This contains the local fax number for the fax destination with fax output with SAPscript (field ITCPO-
TDTELENUM for the parameter OPTIONS of function OPEN_FORM).

&SAPSCRIPT-TELENUME&

This contains the complete fax number for the fax destination with fax output with SAPscript (field ITCPO-
TDTELENUME for the parameter OPTIONS of function OPEN_FORM).

Variables of Structure SYST

All variables of structure SYST, called system variables, can be used in the layout set. Of particular interest
are the variables for the system date and time. These variables indicate the date and time that the output
was created. For the system date, use SYST-DATUM variable, for the system time, use SYST-UZEIT. Note
that you have the formatting options for date and time variables.
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G:  Glossary

Glossary

Term Definition

ABAP/4 Advanced Business Applications Programming language.

Access key The number which that is entered to modify SAP objects. This number is retrieved
from the Online Service System (OSS).

Application server Server where the SAP System runs. The CPU of this computer is used for the
applications that you run.

Bar code Form of representation of numbers and text. Text and numbers are printed with
bars of different width.

Character string Part of a layout set containing formatting information for words within a
paragraph.

Client A client is a legally and organizationally independent subscriber to the system
where all business management data is protected against access by other clients.

Correction and
Transport System
(CTS)

Functionality of the SAP System in order to be able to keep track of modifications to
SAP objects as well as on customer objects. The CTS also supports transports
between a development system and a productive system.

Customer name
range

Range of names that a customer can use for own objects. SAP promises not to
deliver any objects within this name range.

Customizing Adapting the R/3 System to the business processes and business functions of a SAP
customer.

Device type Type of an output device, (e.g., types of printers).

DIN A4 Page format used in Germany and Australia (et al.). DIN is the German
abbreviation for the German Institute of Standards. The format is 210 x 279 mm.

GUI Graphical User Interface. This is how an application is presented on the screen.

Header 1. General part of a layout set.

2. General part of a document.

Implementation
Guide (IMG)

The IMG is used to guide you through the customizing of your system during
implementation or any further changes. For these reasons it provides you with
structured views on all customizing activities, the corresponding documentation
and some project management facilities.

Item Part of a document. Items are the positions of a document. Theoretically, the
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Term Definition
number of items is not limited.

Layout set A layout set describes the layout of output documents. It contains information
about where on a page you want to have which text and variables from the R/3
System.

Layout set element Part of a layout set.

LETTER Page format used in USA and Canada (et al.). The format is 8 ½ x 11 inches.

Line spacing Distance between the top of a line and the top of the following line.

Macro Set of commands executable by one command.

OSS SAP’s Online Service System. You can get the access key for maintaining objects in
your SAP System as well as notes about the R/3 System.

Page The portion of a layout set or view on a layout set where the names of the pages
with a different layout are listed.

Page window The portion of a layout set or view on a layout set that describes an area on a page
layout.

Paragraph The portion of a layout set or view on a layout set that contains formatting
information for a paragraph of text.

Preconfigured
client

Client of the R/3 System provided by SAP. This client contains customizing for
smaller companies.

Preprinted form Paper on which the output of the SAP System should be printed. The paper already
contains most of the information that is not coming off the SAP System. The form
can be a multi-layer form, already containing a company logo or other constant
text.

Print control Sequence of control characters sent to the printer (e.g., a sequence to switch to
another font).

Program variant Named set of preset variables that can be used to start a program with filled
parameters.

Report A program used to read and evaluate data in database tables.

SAPscript SAP’s tool to describe layouts (et al.). With this tool it is possible to create, display
and change layout sets.

SAPscript editor Special editor used by SAPscript.

Standard layout set Layout set included in the standard R/3 System.

Standard text Fix text stored in the SAP System.

Structure Object defined in the Data Dictionary which groups fields together.
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Term Definition

Sub-structure Structure which is part of another structure.

Table Database table defined in the Data Dictionary similar to a structure.

Test print Output of a layout set with simulated data in order to check the layout.

Text element 1. Part of the window where the text of a window is defined.

2. Whole text of a window can be divided in text elements.

This is a named fraction of the text of a window.

Transaction A transaction covers a logical process in the R/3 System. Transaction examples
include:

• Generating a list of customers

• Changing the address of a customer

• Booking a flight reservation for a customer

• Executing a program

From the user’s point of view, it represents a self-contained unit. In dialog
programming, it is a complex object that consists of a module pool, screens, etc. It is
called with a transaction code.

Transaction Code The sequence of four characters identifying a transaction.

To call a transaction in the R/3 System, enter the transaction code in the command
field. For example, SA38 is the code to directly start SAP programs.

Upload layout sets Inserts layout sets into the R/3 System. The layout sets must exist in a file in ASCII
format.

Window Part of a layout set or view on a layout set containing text and variables. Together
with window coordinates a window becomes an area on a page layout.
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Appendix A:   Sample Printouts of the Nine Layout Sets
The following pages show sample printouts for the layout sets provided on the diskette.
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Part, 4–1
Standard, 2–1, 3–5, 5–1, 7–4
Test print, 5–4
Upload, 1–5, 3–1

Layout Set
Element, 4–1

Line, 5–50
Delete, 5–7, 5–13
Insert, 5–7

Line item, 4–3, 4–6
Line item data, 5–17, 5–19
Lines per inch, 4–3
Logo, 5–29

M

Macro, 5–38
Material text, 7–21
Mode, 3–3

N

Name range, 3–5, 5–2

O

Operation, 7–22, 7–26, 7–31, 7–35
Original language, 3–6
Output formatting, 8–2
Output medium, 7–4, 7–7, 7–19
Output type, 7–4, 7–6, 7–7, 7–8, 7–

9, 7–19

P

Page, 4–1, 4–9
Page format, 1–3, 4–3
Page protection, 8–17
Page Window, 4–1, 4–9
Page Window
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Preconfigured client, 1–3, 3–1, 3–5
Pricing condition, 7–15
Print control, 5–38, 8–16
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Assign, 7–3, 7–46, 7-38
Variant, 7–60
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Print sequence, 7–23, 7–28
Printer type, 5–31
Printing priority, 7–28
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Change text, 7–34
Document text, 7–21
Header text, 7–22
Heading, 7–35
Item text, 7–26
Supplement text, 7–30
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Retain, 4–5

S

Sales organization, 7–9
SAPscript, 1–1, 1–2, 1–5, 2–1

Command, 4–7
Control command, 1–1, 8–1,
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Part, 1–1
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Header, 7–9, 7–51
Sender, 7–51
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Signature, 7–51
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Tab, 5–7, 5–9, 5–49
Technical info, 5–18
Text, 4–6
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Text block
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Text element, 4–7, 4–9
Third-party solutions, 6–2
Type, 4–6
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Underline, 4–5
User-exit, 5–17, 5–25, 5–28
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Window, 4–1, 4–6, 4–9
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